TEAMCENTER

Briefcase Browser

Teamcen ter 2412

SIEMENS



Unpublished work. © 2025 Siemens

This Documentation contains trade secrets or otherwise confidential information owned by Siemens Industry Software Inc. or
its affiliates (collectively, “Siemens”), or its licensors. Access to and use of this Documentation is strictly limited as set forth in
Customer’s applicable agreement(s) with Siemens. This Documentation may not be copied, distributed, or otherwise disclosed
by Customer without the express written permission of Siemens, and may not be used in any way not expressly authorized by
Siemens.

This Documentation is for information and instruction purposes. Siemens reserves the right to make changes in specifications
and other information contained in this Documentation without prior notice, and the reader should, in all cases, consult
Siemens to determine whether any changes have been made.

No representation or other affirmation of fact contained in this Documentation shall be deemed to be a warranty or give rise to
any liability of Siemens whatsoever.

If you have a signed license agreement with Siemens for the product with which this Documentation will be used, your use of
this Documentation is subject to the scope of license and the software protection and security provisions of that agreement.
If you do not have such a signed license agreement, your use is subject to the Siemens Universal Customer Agreement, which
may be viewed at https://www.sw.siemens.com/en-US/sw-terms/base/ucal, as supplemented by the product specific terms
which may be viewed at https://www.sw.siemens.com/en-US/sw-terms/supplements/.

SIEMENS MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS DOCUMENTATION INCLUDING, BUT NOT LIMITED

TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, AND NON-INFRINGEMENT OF
INTELLECTUAL PROPERTY. SIEMENS SHALL NOT BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, CONSEQUENTIAL OR
PUNITIVE DAMAGES, LOST DATA OR PROFITS, EVEN IF SUCH DAMAGES WERE FORESEEABLE, ARISING OUT OF OR RELATED

TO THIS DOCUMENTATION OR THE INFORMATION CONTAINED IN IT, EVEN IF SIEMENS HAS BEEN ADVISED OF THE POSSIBILITY
OF SUCH DAMAGES.

TRADEMARKS: The trademarks, logos, and service marks (collectively, "Marks") used herein are the property of Siemens or other
parties. No one is permitted to use these Marks without the prior written consent of Siemens or the owner of the Marks,

as applicable. The use herein of third party Marks is not an attempt to indicate Siemens as a source of a product, but is

intended to indicate a product from, or associated with, a particular third party. A list of Siemens’ Marks may be viewed at:
www.plm.automation.siemens.com/global/en/legal/trademarks.html. The registered trademark Linux® is used pursuant to a
sublicense from LMI, the exclusive licensee of Linus Torvalds, owner of the mark on a world-wide basis.

About Siemens Digital Industries Software

Siemens Digital Industries Software is a global leader in the growing field of product lifecycle management (PLM),
manufacturing operations management (MOM), and electronic design automation (EDA) software, hardware, and services.
Siemens works with more than 100,000 customers, leading the digitalization of their planning and manufacturing processes. At
Siemens Digital Industries Software, we blur the boundaries between industry domains by integrating the virtual and physical,
hardware and software, design and manufacturing worlds. With the rapid pace of innovation, digitalization is no longer
tomorrow’s idea. We take what the future promises tomorrow and make it real for our customers today. Where today meets
tomorrow. Our culture encourages creativity, welcomes fresh thinking and focuses on growth, so our people, our business, and
our customers can achieve their full potential.

Support Center: support.sw.siemens.com

Send Feedback on Documentation: support.sw.siemens.com/doc_feedback_form


https://www.sw.siemens.com/en-US/sw-terms/base/uca/
https://www.sw.siemens.com/en-US/sw-terms/supplements/
http://www.plm.automation.siemens.com/global/en/legal/trademarks.html
https://support.sw.siemens.com
https://support.sw.siemens.com/doc_feedback_form

Contents

Getting started with Briefcase Browser
Sharing data with Briefcase Browser
Briefcase Browser capabilities

Requirements for using Briefcase Browser
Basic tasks in Briefcase Browser

Basic concepts for using Briefcase Browser

Using Briefcase Browser at unmanaged sites
How to compare Briefcase files

How autobaseline (auto_baseline) works for NX data

NX CAD complete Briefcase file requirements
NX part requirements
NX drawing requirements
Ownership transfer concepts
Briefcase Browser application
Briefcase Browser user interface
Briefcase Browser menus
Briefcase Browser buttons
Briefcase Browser views
Briefcase Browser symbols

Install Briefcase Browser 2-1

Configuring Briefcase Browser
Configure site identification

Briefcase Browser preferences

Startup configuration

Assembly load option preferences

NX load options

Briefcase Browser site configuration files

Using Briefcase Browser

Starting Briefcase Browser

Opening and working with Briefcase files
Open a CAD file (create a new CAD object)
Add non-CAD files to a modifiable part
Remove non-CAD files from a modifiable part
Compare Briefcase files

Modify NX data in a Briefcase file

Modify CATIA data in a Briefcase file
Modify JT data in a Briefcase file
Synchronize CAD data

LS UL W U U L W UUIL WL (s §
oo

L LALNN NN AN
VOO DPMNN_L_,ONOOTOUTUN =

RN\ UK UK U (U WU WU WK W |

3-1
3-2
3-3
3-4
3-6
3-7

4-1
4-1
4-3
4-4
4-5
4-6
4-6
4-7
4-7
4-9




Transfer ownership of local parts 4-10

Customizing Briefcase Browser

What you need to know and what you can customize 5-1
Create a plug-in project 5-1
Create a class extension 5-3
Create a file launcher extension 5-3
Create a synchronizer extension 5-4

Troubleshooting

Determining what is wrong A-1
SQL exceptions A-2
Importing a Briefcase file in Teamcenter fails after migration A-2
Fixing an unhandled exception error A-2
Null pointer exceptions A-2
Causes of unexplained errors A-3
NX does not display a part when it is opened from Briefcase Browser A-3

Migrate a managed supplier site to an unmanaged site B-1




1. Getting started with Briefcase Browser

Sharing data with Briefcase Browser

Supplier sites without Teamcenter access (unmanaged suppliers) can use Briefcase Browser to work with
Teamcenter Briefcase files. Briefcase Browser is a Windows application.

A Briefcase file is a compressed file that contains TC XML formatted data and the associated binary CAD
and JT files that create a valid Teamcenter product structure. Briefcase files let you exchange product
data containing computer aided design (CAD) and JT files, with their associated metadata, with sites that
use Teamcenter to manage their product data

Briefcase Browser is one of several solutions Teamcenter offers to meet different data sharing needs.

Data
Sharing
Share and synchronize data in near Multi-Site Bulk Data Exchange large volumes of data when
real-time between Teamcenter Collaboration Migration pepulating test envirenments,
sites across the entire enterprise. Tools migrating enterprise data,

consolidating Teamcenter sites, and
when transitioning to Teamcenter from
Teamcenter Enterprise.

Briefcase PLM XML
Export and
(TC XML) Taport
Specify and share Teamcenter data Share Teamcenter data for use with
with connected and unconnected third-party applications using the ope:
sites using TC XML and Briefcase files. PLM XML format.
Mon-Teamcenter sites can use
Briefcase Browser to view and
manage the shared data.
Where do | go from here?
n . .
aAdministrator
Enabling Briefcase Browser for users. See Requirements for using Briefcase
Browser.

Configuring and exchanging Teamcenter data.  See Data sharing concepts.

Learning about Multi-Site Collaboration. See Using Multi-Site Collaboration.
~ .
@ Business User

Learning more about Briefcase Browser. See Briefcase Browser capabilities and Basic
tasks in Briefcase Browser.
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_ 1. Getting started with Briefcase Browser

Using Briefcase Browser. See Starting Briefcase Browser and Opening
and working with Briefcase files.

Working with CAD files. See Open a CAD file (create a new CAD
object).

Briefcase Browser capabilities

Teamcenter offers a broad range of features. Although Briefcase Browser supports many of these
features, it does not support them all. Unless a feature is specifically identified as supported here, it
may be not supported.

General capabilities
* Open and display unmanaged Briefcase files.

Only datasets that are attached to item revisions are displayed. Briefcase Browser shows only CAD
attachments for replica parts when you open or synchronize a Briefcase file.

» By default, you can update CAD modified datasets in a Briefcase file.
* Open JT files in JT2Go or Teamcenter lifecycle visualization.

* With the Briefcase Browser JT plugin installed, open and update JT files supplied to you in Briefcase
files. When existing JT files are not delivered in the Briefcase file, Briefcase Browser automatically
creates component and assembly JT files based on the contents of the Briefcase file.

 Distinguish objects based on site ownership, and allow user modifications when rules permit.
* Create a Briefcase file from a new CAD assembly.

* Open a Briefcase file that contains incomplete CAD data. By default, Briefcase Browser completes
CAD incomplete packages automatically. If Briefcase Browser cannot complete the CAD assembly, it
displays a warning message indicating the completion process failed and provides the reason.

If a CAD assembly is incomplete, Briefcase Browser completes it by creating placeholder parts for
missing parts so the Briefcases open the CAD assembly without a broken node.

* Open a Briefcase file containing:
* CAD data that contains multiple revisions of an item
* CAD data that contains a precise configuration

e CAD data that contains variants
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Briefcase Browser capabilities _

* CAD data that contains partial BOM data. Unselected siblings are displayed as stubs when the
imported file is for design change. Unselected siblings are not in the import file when the imported
file is for reference.

e CAD data that contains delta data

* Create a Briefcase file with non-CAD attachments such as Microsoft Word and JT along with the CAD
assembly data.

* Add non-CAD datasets.
* Briefcase Browser does not support multiple root assemblies in a single Briefcase file.
Transferring files between managed and unmanaged sites

Briefcase Browser is intended and supported for exporting Briefcase files from managed sites for use at
unmanaged sites and for importing files from unmanaged sites into managed sites as follows:

Teamcenter Briefcase Browser

Because you can use Briefcase files to transfer Teamcenter data between both managed (OEM) and
unmanaged (supplier) sites, you must be aware of what to expect when transferring data between
different site types.

Caution:

When you open a Briefcase file that is targeted to another Teamcenter site, save, launch,
synchronization, and compare operations are not supported at your site.

Similarly, when you open a Briefcase file that was created at an unmanaged (non-Teamcenter) site,
save, launch, synchronization, and compare operations are not supported at your site.

If you attempt to use the listed operations in these transfer scenarios, results may be reliable.

NX-specific capabilities

* Display a warning when a Briefcase file containing NX data is not CAD complete. This behavior is
configurable and is not the default behavior. A Briefcase file is CAD complete if all or none of the item
revisions are associated with a UGMASTER dataset type and the structure has not been modified in
Teamcenter.

Briefcase Browser, Teamcenter 2412 1-3
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_ 1. Getting started with Briefcase Browser

* Create new UGMASTER and UGPART (base, model, and drawings) dataset types in NX and add them

and their associated TC XML data to a Briefcase file.

Briefcase Browser does not support absolute positioning. Also, it does not support Briefcase files
containing NX data with substitutes or alternatives, but these do not generate errors when creating
the Briefcase file. However, Briefcase Browser does display errors if you attempt to read a Briefcase file
that contains any of the unsupported data.

Caution:

NX part files contain locale-specific data in a part’s history. Because Briefcase Browser
communicates directly with NX, both applications must use the same locale. Do not change the
locale of the NX host as this determines the locale used in NX part files. Changing the NX locale
can cause a Briefcase file that contains NX parts to fail when you save it in Briefcase Browser.

The Briefcase Browser locale is also determined by the operating system locale unless it is
overridden by a start-up setting. Siemens Digital Industries Software recommends that you install
Briefcase Browser on the host that is running NX and allow the operating system to determine the
Briefcase Browser locale. This avoids errors resulting from data that is in the wrong locale.

CATIA-specific capabilities

* Create new CATProduct, CATPart, and CATDrawing dataset types in CATIA and add them and their

associated TC XML data to a Briefcase file.

* Open a Briefcase file containing CATIA data that contains incomplete CAD data. Briefcase Browser

completes the CAD assembly by creating a reference structure during the postbriefcase open activity
if the exported data file is for reference and contains build component structure.

If the Briefcase file is missing the CAD root node, Briefcase Browser creates a CATProduct or CATPart
object in the root file path for use in viewing the CAD data in CATIA and for synchronization actions. If
other nodes are missing, Briefcase Browser creates a reference component on its immediate parent.

If Briefcase Browser cannot complete the CAD assembly, it displays a warning message indicating the
completion process failed and provides the reason.

When opening a Briefcase file exported for reference transfer, Briefcase Browser creates a root
CATProduct object and builds the component structure with CATProduct and CATIA graphical
representation (CGR) datasets. Because reference transfers are read-only, synchronization is not
available. Using the View in CATIA command on the Tools menu or the toolbar launches the
Briefcase Browser built component structure in CATIA.

For more information, see the CATIA plugin (BBpC) documentation.
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Requirements for using Briefcase Browser _

Requirements for using Briefcase Browser

Prerequisites

There are no prerequisites for installing and running Briefcase Browser. However, to perform specific
actions in Briefcase Browser, there are some requirements:

Briefcase Browser requires a 64-bit Window operating system.
* You must have Java Runtime Environment (JRE) 1.8 or later installed.
For NX, the JRE version must be the same as that required by the version of NX you are using.

* To create new NX assemblies or modify existing NX assemblies or components, you must have
Siemens Digital Industries Software NX 9.0 or later installed.

* To create new CATIA assemblies or modify existing CATIA assemblies or components, you must have
CATIA installed where Briefcase Browser can access it.

* To customize Briefcase Browser, you must have Eclipse software with version 3.8 of the Eclipse RCP
installed.

See the Hardware and Software Certifications knowledge base article on Support Center for the latest
information about supported software versions.

Enable Briefcase Browser

If you receive an unmanaged site Briefcase configuration file from your Teamcenter manufacturer (OEM)
or supplier, you must load it to set the proper site attributes before you use Briefcase Browser.

Configure Briefcase Browser

You can change your Briefcase configuration, when required, from within the Briefcase Browser
interface.

To customize your Briefcase Browser, copy CustomDatasetMappings to the current configuration.
Start Briefcase Browser

Start the application as you do any application on your system. No password or user ID is required.

Basic tasks in Briefcase Browser

Use Briefcase Browser to do the following basic tasks:
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_ 1. Getting started with Briefcase Browser

* Create a Briefcase file from a native CAD assembly.

» Attach non-CAD files such as Microsoft Word or JT to any modifiable parts from the CAD assembly
while creating a Briefcase file.

* Open a Briefcase file and launch the CAD application to update local supplier-owned assemblies or
components.

* Open a CAD assembly, in the associated CAD application, modify and save the assembly, synchronize
the CAD assembly data, and save the Briefcase file.

For NX data, if you have autobaseline turned on in your CustomMappings.xml configuration file,
Briefcase Browser creates baseline revisions. It also assigns a release status you can select. The release
status is also defined in the CustomMappings.xml configuration file.

* Launch a JT viewer and load an assembly for viewing.
* Launch a non-CAD file for viewing.

* Synchronize a Briefcase file with components updated or added to an assembly in your CAD
application.

Note:

To add an object to a CAD assembly in NX, you must choose Assemblies->Add component.
If you copy and paste the object, Briefcase Browser does not recognize the relationship during
synchronization and the object does not appear in the updated Briefcase file.

Basic concepts for using Briefcase Browser

Using Briefcase Browser at unmanaged sites

Briefcase Browser requires a site configuration file that is supplied by a site that manages product data
in Teamcenter, normally an original equipment manufacturer (OEM) site. Sites that manage product
data in a file system outside of Teamcenter are considered unmanaged sites. Briefcase Browser can load
Teamcenter Briefcase files that contain data intended for unmanaged sites and allows write permissions
to the datasets that the unmanaged site owns or have been checked out to the unmanaged site.
Therefore, the site ID must be obtained from a configuration file supplied to the unmanaged site to
maintain write control. This is a read-only preference.

If your site has custom attributes, the configuration file can contain the user attribute mapping file that
Briefcase Browser uses to map the attribute to a specified object in the TC XML file. Also, the schema file
preference must be set to the correct schema to allow Briefcase Browser to correctly load and display the
structure. This can also be supplied in the configuration file that the manages site supplies.
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How to compare Briefcase files _

Note:

The uniform resource identifiers (URIs) that appear in the headers of PLM XML and TC XML files
serve as namespace names, which are unique identifiers for an XML vocabulary. Although they are
URIs, they are not used to identify and retrieve Web addresses.

Teamcenter supports both revision and occurrence (unit number and date) effectivity. However,
Briefcase Browser supports only revision effectivity. Therefore, if a Briefcase file for an unmanaged
site has assemblies with occurrence effectivity, the unconfigured occurrences are included in the file.
Briefcase Browser supports precise, imprecise, and hybrid assemblies.

When you set the working directory in Briefcase Browser to a directory that contains existing structure
files, Briefcase Browser overwrites any OEM owned parts or assemblies in the directory but maintains
any unmanaged site owned parts or assemblies. You can then synchronize the Briefcase file to the
working directory.

Briefcase Browser reads the XML configuration files in the bbworkspace/configurations directory. Each
configuration has a separate directory that contains the site-id.properties file as a minimum. It may also
contain any of the additional configuration files described in Briefcase Browser site configuration files.

Caution:

You cannot attach the same non-CAD dataset file under two different locally owned objects in
Briefcase Browser. To accomplish this you must rename the file prior to attaching it to the second
object.

How to compare Briefcase files

You can use Briefcase Browser to compare two existing Briefcase files to determine the changes between
the two. For example, if the BCZ_X_01_03_2012.bcz file is open in the Existing Structure tab, click the
Compare briefcase to another briefcase button g, and select the BCZ_Y_02_04_2012.bcz file and the
following occurs:

* The Proposed Structure tab opens in the structure view and displays the BCZ_Y_02_04_2012.bcz file
contents. This contents appears the same as if it was opened in the Existing Structure tab.

* The Red Line Structure tab opens in the structure view and displays the differences between the
BCZ_X_01_03_2012.bcz and the BCZ_Y_02_04_2012.bcz file. This tab displays removed, added, and
changed objects in different text colors. The color for removals, additions, and changes is set in the
preferences dialog box.
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_ 1. Getting started with Briefcase Browser

Briefcase comparison preferences default colors
Additions
Removals

Changes

* If the BCZ_X_01_03_2012.bcz file has a C1 component and the BCZ_Y_02_04_2012.bcz file does
not, the C1 component is considered removed and displays in the text color set for removed objects
(red by default) in the Red Line Structure tab.

* |f the BCZ_X_01_03_2012.bcz file does not have a C2 component and the BCZ_Y_02_04_2012.bcz
file does, the component is considered added and displays in the text color for added objects (green
by default) in the Red Line Structure tab.

* If both Briefcase files contain a C3 component, but the attributes of the component are different, the
component is considered changed and displays in the text color for changed objects (blue by default)
in the Red Line Structure tab. If both files contain the component and the attributes are the same,
the component appears in black text.

* If both Briefcase files contain a C3 component, but the datasets of the component are not the
same (for example, the component also contains non-CAD datasets), the component is considered
changed.

The Red Line Structure tab shows the union of all components in the compared Briefcase files. If a
Briefcase file is compared to itself all three tabs contain identical views.

Be aware that Briefcase files generated at an unmanaged supplier site contain stub parts for all managed
site owned parts (referenced parts). An OEM site generated Briefcase file contains the full objects.
Comparing an OEM Briefcase file to a supplier site Briefcase Browser generated file that contains the
same OEM site owned parts results in an incomplete structure for the stubbed objects in the Red Line
Structure tab.

Note:

If a source Briefcase file contains NX data that has additional datasets or forms, this data is shown
as changes in the Proposed Structure tab. This is because in other CAD applications the additional
datasets are not generated when the CAD data is saved.

How autobaseline (auto_baseline) works for NX data

Briefcase Browser provides an autobaseline feature. This feature supports the baseline functionality
of Teamcenter. If all criteria are met when after you have modified an assembly, Briefcase Browser
automatically creates or updates an objects revision. This revision becomes the baseline when the
Briefcase Browser file is imported into a Teamcenter site. The autobaseline feature is controlled by the
CustomMappings.xml file.
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The primary criteria for autobaseline of a part are:

* The part must have been saved in a Briefcase file.

Note:

When you receive a Briefcase file created by a managed site, for example an OEM site, that
contains one or more parts or an assembly that has ownership transferred to your site, this
criterion has not yet been met. You must open and save the Briefcase file in Briefcase Browser at
least once before the part is considered saved in a Briefcase file.

* The part that you have modified must be locally owned (supplier part).

Briefcase Browser creates a baseline revision for parts and the assemblies containing the revised parts
if the assembly is also locally owned. The autobaseline continues up the family tree (child to parent
to parent’s parent) until an assembly that is not locally owned is encountered or the top assembly is
reached.

The following examples illustrate the autobaseline feature:

1. Inthe LocalAssy/A assembly structure, you revise the LocalComp2/A part that is a locally owned
part.

% LocalAssy/A
% LocalSubAssy/A

% LocalComp2/A

All three items become revision B because no remote (OEM owned) part was encountered.

 LocalAssy/B
% LocalSubAssy/B

% LocalComp2/E

2. This time in the LocalAssy/A assembly structure, you revise LocalSubAssy/A that is a locally owned
part.

“» LocalAssy/B
% LocalSubAssy/B

% LocalComp2/A

In this case, the LocalComp2/A item is not revised because it is a child to the revised item.
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3. This LocalAssy/A assembly structure contains a remote OEM owned item and you revise
LocalComp2/A that is a locally owned child part to the OEM owned item.

% LocalAssy/A
% OemSubAssy/A

% LocalComp2/B

Only the LocalComp2/A item is revised because the parent OEM owned item cannot be revised.
This prevents the revision of the parent objects.

Briefcase Browser creates a baseline for items in a Briefcase file that are locally owned the first the file is
saved from Briefcase Browser. Therefore, the following applies for Briefcase files sent from a Teamcenter
site:

1. You receive an entire assembly (Assy/A item) created at the OEM site with ownership transfer to
your site. You revise a drawing for a component (Comp1/A) in your CAD application.

% Assy/A
% SubAssy/A

% Comp1/A
% Comp2/A

2. You synchronize the revised assembly (Assy/A) in the Briefcase file and save it. This creates a
baseline item (Assy/A) in your Briefcase file.

* Assy/A baseline
% SubAssy/A

% Comp1/A
% Comp2/A

3. You subsequently create a new component drawing in your CAD application (Comp2/A) and
synchronize it in the Briefcase file. This creates a new revision of the assembly (Assy/B). However,
the new drawing is not listed in the dataset view for the component because the assembly is a
baseline.

s Assy/B baseline A
% SubAssy/B

% Comp1/A
% Comp2/B
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4.  You save the assembly. Because a baseline was created when the original revision was saved, this
generates an error in Briefcase Browser.

NX CAD complete Briefcase file requirements

If you want to enforce CAD complete assembly requirements at you site, set the
BB_CAD_VALIDATION_CHECK environment variable to true on the host running Briefcase Browser.
When this variable is set to true, you can export only CAD complete assemblies to unmanaged sites. The
following requirements must be satisfied before an assembly is CAD complete:

* Every node must be associated to a UGMASTER dataset.

* The structure in Teamcenter must be synchronized with the CAD structure.

* To verify that an assembly is CAD complete, the following conditions must be satisfied in the TC XML
file that you want to export in a Briefcase file:

* The number of UGMASTER elements is equal to the number of ItemRevision elements.
* The number of BVR elements is equal to the number of BVRSyncInfo elements.

* Atany BVR level, the timestamp of the BVR (struct_last_mod_date attribute) must match
the timestamp of the BVRSyncInfo form (last_struct_mod attribute). You can use the
BRIEFCASE_export_CAD_incomplete preference to export incomplete CAD structures. However,
support for incomplete CAD structure export is limited.

NX part requirements

CAD assemblies or parts that are opened from NX into Briefcase Browser must meet the following file
naming conventions to allow Briefcase Browser to save them properly to a Briefcase file:

The dataset file name for a CAD part must be of the form part-name_item-id_rev-id.prt. For example, if
the CAD part has the name front_panel and is identified as 00009 and it is revision A, the dataset file
name must be front_panel_00009_A.prt. If you have not supplied the following attributes for the NX
part, Briefcase Browser infers these from the file name because they are mandatory in Teamcenter:

* The DB_PART_NAME attribute, for example, front_panel.
* The DB_PART_NO attribute that matches the item-id portion of the file name, in this case, 00009.
» The DB_PART_REV attribute that matches the rev-id portion of the file name, in this case, A.

Any special characters in the required attributes are converted to underscore characters (_) to ensure
they are valid in Teamcenter. For example, if the part has a part file name has a value of bulb t#1, the
part number and the part revision is A. Briefcase Browser converts the file name to bulb_t_1_A.prt.
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Caution:

In Microsoft Windows, the vertical bar (]) and the asterisk (*) characters are invalid in file names.
Therefore, the item ID and the part name values cannot contain either of these characters.

NX drawing requirements

NX CAD drawings are created using a base model concept, that is, they are always associated with

a unique CAD Master file. The dataset file name for a drawing requires a format similar to CAD Part,
item-id_rev-id_s_dwg.prt or item-id_rev-id_m_dwg.prt. Drawings require the same attributes as a CAD
part.

Briefcase Browser reads essential attributes from drawings itself, if already defined.

If essential attributes are not defined in drawings then Briefcase Browser reads them from its only child
which is a CAD Master file.

Note:

Non-CAD files following the described naming convention and with extensions defined in
CustomDatasetMappings.xml are attached automatically while opening a CAD assembly and
performing synchronization.

For example, 00009 _A word.doc is automatically added to a 00009_A part. However, 00009 _A
text.txt is not added to that part as .txt is not listed in the default CustomDatasetMappings.xml.

Ownership transfer concepts

In Briefcase Browser you can mark local (supplier) parts for transferring the ownership to the target site
from the Existing Structure view and the Ownership Transfer dialog box. The ownership of parts are

transferred to the target site only after the Briefcase is saved. Once the Briefcase is saved, the parts are

no longer owned by the supplier.

When a part is marked for ownership transfer in the Existing Structure view, it is listed in the
Ownership Transfer view. If none of the parts are marked for ownership transfer or if no assembly
is selected in the Existing Structure view, the Ownership Transfer view is empty.

You can also select multiple parts for ownership transfer from the Existing Structure view.

Note:

When a single part is selected, the context menu shows either Mark for Ownership Transfer or
Unmark Ownership Transfer depending on the current status of the selected part.

When multiple parts are selected, the context menu shows both options, Mark for Ownership
Transfer and Unmark Ownership Transfer, irrespective of the selection.
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Once a part is marked for ownership transfer, the icon changes from “ to €.

You can unmark parts from the Existing Structure view or from the Ownership Transfer view using
the context menu Unmark Ownership Transfer. To clear all selections, click # from the Ownership
Transfer view.

You can also mark/unmark parts for ownership transfer from the Ownership Transfer dialog box.
This dialog box can be opened by clicking Tools->Transfer Ownership or by selecting ;*; Ownership
Transfer from the toolbar button.

The display of the parts listed in the Ownership Transfer dialog box depends on what is selected in the
Existing Structure view. If no parts are selected in the Existing Structure view, all the parts are listed. If
a sub-assembly is selected, all the local parts of the sub-assembly are listed.

If a part appears multiple times in the Existing Structure view under different sub assemblies, it is listed
only once.

The following fields in the Ownership Transfer dialog box corresponds to various actions that can be
performed from the user interface:

Function Description

Mark / Unmark The first column (Transfer) shows the status of each part as marked or
unmarked. If the check box is selected, the part has been marked for
ownership transfer.

To transfer the ownership of parts, you can select or clear the check box
against the relevant part. For bulk selecting or clearing the parts in the list,
select or clear the check box against the column Transfer, as appropriate.

Sort You can sort columns using column headers.

Filter To filter specific parts, enter filter criteria in the box below the column
headers and tab out from the columns to start filtering data. For the first
column, you can filter by selecting Marked or Unmarked from the check box
in the column header.

Clear any applied filter by clicking the filter icon.

Find Press Ctrl + F to find a specific part.

Save to Excel Press Ctrl + E to export any row to Microsoft Excel.
Print Press Ctrl + P to print the details of a specific part.
Freeze | Unfreeze Press Ctrl + Shift + F to freeze a column or a row.
Columns

Press Ctrl + Shift + U to unfreeze a column or a row.

Configure Columns Right click the column header or filter row to open a context menu that
allows you to:
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Function Description

* Hide column: Allows you to hide a specific column.
* Show all columns: Allows you to display all columns.

* Choose columns: Opens a dialog box that allows you to add or remove
any column from a view or change the sequence of the columns displayed.

* Clear all filters: Allows you to clear any filters that you may have applied
earlier.

The ownership of the parts is transferred only after saving the Briefcase. The local parts whose
ownership is now transferred are now read-only as they are now owned by target site. These parts

)

are indicated by the icon .

Briefcase Browser application

Briefcase Browser user interface

Briefcase Browser is an Eclipse-based Java application and that uses the look and feel of the Teamcenter
applications user interface (Ul), which is composed of perspectives, views, and editors. A perspective

is an arrangement of views. A view is a tabbed window within the Ul that provides a view of data.

An editor is a window that allows you to edit source files. You can rearrange the user interface in

any configuration by dragging and dropping views and editors. The example provided is a common
perspective of the interface. Depending on your site's settings, Briefcase Browser may display with
different colors and other visual differences.
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1 Briefcase Browser toolbar Provides buttons for quick access to the most
commonly used Briefcase Browser menu commands.

2 File location Provides the path and XML file name for the Briefcase
content currently displayed in the structure view.

3 Structure view Contains the Existing Structure tab that shows the
currently loaded assembly and allows you to navigate
the assembly structure. An Existing Structure tab
opens for each file you load. The path and file name of
the each assembly loaded into an Existing Structure
tab is shown on the tab at the top of the view. You
switch between structures using the top tabs.

If you are comparing two Briefcase files, it contains
the Proposed Structure and Red Line Structure tabs.

The structure view also contains the Controls/
Properties tab that displays the working directory for
the currently selected structure tab and schema used
to process the structure.

4 Error Log view Displays operational message status and errors
messages.
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5 Item Properties view

6 Data Sets view

7 Progress view

8 Ownership Transfer view

Displays the properties of the item selected in the
Existing Structure tab.

Displays the datasets associated with the selected
item in the Existing Structure tab and allows you to
open the dataset in the associated application.

Lets you monitor progress messages and units of
completed work for selected long-running jobs (those
lasting more than a second) such as opening a
Briefcase file.

Displays parts marked for ownership transfer. The
view also allows you to unmark parts marked for
ownership transfer.

The Datasets Properties and Changes views may also be displayed.

Briefcase Browser menus

Use the File menu commands to manage Briefcase files.

Command

Open Briefcase

Open CAD Assembly

Save Briefcase

Export to CSV

Close Briefcase

Exit

Purpose

Displays the dialog box that allows you to navigate to and
select the desired Briefcase file that you want to manage.

Displays the dialog box that allows you to navigate to and
select the desired CAD file that you want to manage.

Saves the currently loaded Briefcase file in the working
directory.

Exports the Briefcase file contents to a text file with
comma-delimited fields suitable for opening in a spreadsheet
application.

Unloads the current Briefcase file from Briefcase Browser.

Exits Briefcase Browser.

Use the Tools menu commands to start associated tools and access troubleshooting tools.
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Command Purpose

Launch JT Opens the selected object in the JT viewer. A JT dataset must
be associated with the object.

Launch NX Launches NX and loads the selected part or assembly and its
children.

View in CATIA Launches CATIA and loads the selected part or assembly and
its children.

Compare Briefcase Allows you to select another Briefcase file and show the

differences between the currently existing structure and the
selected Briefcase file structure.

Synchronize Refreshes the existing structure in the structure editor with
the CAD tool changes.
Debug The Debug command contains a submenu of commands
that provide the following:
Trace Turns on the trace debug option that
includes additional information in the log
file.

Archive Log Opens a dialog box that allows you to save

File the contents of the current log file in an
archive (.zip) file format. The compressed
file saves disk space and allows easy transfer
of log file information, such as through e-
mail.

Ownership Transfer Allows you to open Ownership Transfer dialog box to mark
parts for ownership transfer.

Ownership Transfer is displayed only when you open a CAD
assembly.

Add Dataset Allows you to add non-CAD files such as Microsoft Word or JT
to the CAD assembly.

Add Dataset is displayed only when you open a CAD
assembly.

Use the Window menu commands to apply views to the perspective and access preference settings.
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Command

Show View

Preferences

Reset Perspective...

Briefcase Browser buttons

Purpose

Opens a dialog box that allows you to select the desired
views.

Opens a dialog box that you can use to view and set
preferences.

Opens a dialog box that allows you to reset the current
Briefcase perspective to its default view.

Briefcase Browser contains the following buttons.

Button

©

Function

Open Briefcase

Open CAD
assembly

Save

Open Ownership
Transfer dialog box

Add Dataset

View JT model

View CAD model in
NX

View CAD model in
CATIA

Compare Briefcase
files

Synchronize

Synchronize
Briefcase

Description

Opens the navigation dialog box in which you select a Briefcase
file to load.

Opens a CAD assembly file. This creates the required TC XML data
for the assembly to make a valid Briefcase file.

Allows you to save the Briefcase file.

Allows you to open Ownership Transfer dialog box to mark parts
for ownership transfer.

Allows you to add non-CAD files such as Microsoft Word or JT to
the CAD assembly.

Launches the JT viewer and loads the currently selected JT
assembly.

Launches NX and loads the currently selected NX assembly or
component.

Launches CATIA and loads the currently selected CATIA assembly
or component.

Compares the currently loaded Briefcase file to another Briefcase
file that you select and displays the differences in a new tab.

Synchronizes the Briefcase file with changes made in NX.

Synchronizes the Briefcase file with changes made in CATIA.
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Briefcase Browser views

Most Briefcase Browser views can be customized and may be stacked to provide tab access to the view.
The structure view tabs cannot be customized.

Tab Description

Existing Structure Displays a view of the currently loaded Briefcase file assembly structure,
consisting or rows of objects and columns of attributes.

Controls/Properties Displays the working directory for the currently loaded Briefcase file and
the schema that it is based on.

Proposed Structure Displays a view of a Briefcase file assembly structure that is being
compared to the Existing Structure tab assembly structure.

Red Line Structure Displays a view of a the differences between the Existing Structure tab
assembly structure and the Proposed Structure tab assembly structure.

Briefcase Browser symbols

Symbol Name Description

% Item revision Indicates the object is a Teamcenter item revision. These are
the objects that can be exported to an unmanaged site. They
contain the related objects, such as datasets, and can contain
other related item revisions.

Item revisions that have small green boxes below them are
owned by a remote site, such as the OEM or another supplier.
They may also contain a lock symbol with a checked-out

symbol (g ).

") UGMaster Indicates the object is an NX model (UGMaster dataset).
e UGPART Indicates the object is an NX model (UGPART dataset).
A Dataset Indicates a dataset object. These are file systems files that can

be used by specific applications.

Stub Indicates an object exists and some metadata about the
object is present but the related datasets or other objects
are not present. Stubs are used mainly for performance by
making the file size smaller but still maintaining the integrity
of the structure.

Vv Attached CAD or JT Indicates that the object has a related CAD or JT file attached.
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Symbol

Name

Properties

Progress

Mark for Ownership
Transfer

Unmark Ownership
Transfer

CATProduct
CATPart
CATDrawing

CATCache

CATShape

Description

Indicates a properties view. These views display object data,
such as name, creation date, ownership, and description
for the selected object. These views also provide Show
Categories, Show Advanced Properties, and Restore
Default Value buttons for use as appropriate.

Indicates the Progress view.

Indicates that a part can be marked for ownership transfer.

Indicates that you can unmark a part that was marked for
ownership transfer.

Indicates the object is a CATIA product dataset.
Indicates the object is a CATIA part dataset.
Indicates the object is a CATIA drawing dataset.

Indicates the object is a CATIA graphical representation (CGR)
dataset.

Indicates the object is a CATIA shape dataset.
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Use this procedure to install Briefcase Browser. Doing so installs Briefcase Browser with the plugin for
NX, for other applications such as CATIA, or for use with JT files. Only one plugin can be installed at a
time.

1. Acquire the Briefcase Browser and appropriate plugin kits and extract them locally.
The kits can be downloaded from Support Center.

2. Ensure you have the required Java Runtime Environment (JRE) installed and that your
JAVA_HOME environment variable is set to use that version

3. If you are using the plugin for NX, perform the following steps:

a. Ensure the value of the UGII_ROOT_DIR environment variable is set to the location of the root
directory for the NX installation that you use with Briefcase Browser.

b. Add the UGII_ROOT_DIR and UGII_BASE_DIR environment variables to the start of the PATH
environment variable value.

c. Openacommand window and run the following batch file:
bb_install_path\BB\BB_version\ConfigureNXplugins._bat
The NX instance and Java virtual machine used by Briefcase Browser must be 64 bit.

If you have multiple versions of NX installed on your host, the version that Briefcase Browser uses is
determined by the NX version instance that is in the Windows registry.

4.  Place the Briefcase Browser archive file (bb_wntx64.zip) in the directory in which you want to
install it. Unzip the file.

5. If you are using a non-NX CAD program plugin (such as the plugin for CATIA), remove the following
file from your system.

bb_install_path\BB\BB_version\plugins\com.teamcenter _bce.cad.nx.version_and date.
jar
Refer to the instructions provided with the BBpC plug-in in Support Center for information about

differences in the installation process.

6. If you are using the Briefcase Browser JT plugin, open a command window and run the following
batch file:
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10.

bb_install_path\BB\BB_version\ConfigureBBJTplugins.bat

TCXML.xsd is a file Briefcase Browser uses to load, display, create, preview, and compare Briefcase
files. This file is typically supplied by the managed (OEM) site to the supplier (unmanaged) site.
Copy TCXML.xsd to the following directory.

bb_install_path\BB\BB_version\bbworkspace\configurations

Start the Briefcase Browser application. You must accept the displayed agreement the first time
you start the browser.

If Briefcase Browser fails to start, check the log files in the following directory:
bb_install_path\BB\BB_version\workspace\.metadata
Set the Briefcase Browser preferences as described in Briefcase Browser preferences.

Identify the site with which you are sharing data as described in Configure site identification.
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Configure site identification

Once Briefcase Browser is installed, use the following steps to configure Briefcase Browser to exchange
data with a particular Teamcenter (OEM) site. After following these steps, the configuration will appear
in the Configuration Name list on the Preferences dialog box.

1. Start Briefcase Browser and choose Window = Preferences.
2. Under Configuration Name, click New.

3. Enter a name identifying the site configuration, the site ID provided by the Teamcenter site, and
click OK.

A new directory is created to hold the site's configuration files. For example:
bb_install_path\BB\BB_version\bbworkspace\configurations\new_site
4. Close Briefcase Browser.
5. Navigate to the following directory.
bb_install_path\BB\BB_version\example\bbworkspace\configurations\example

6. Excluding the site-id.properties file, copy the rest of the \example directory's contents to the
directory you created at the start of this procedure.

7. Open the following file in a text editor.

bb_install_path\BB\BB_version\bbworkspace\configurations\new_site\CustomMapp
ings.xml

8. In CustomMappings.xml, update the values of oem_name and site_id to the values assigned to
the Teamcenter (OEM) site from which you are receiving data. For example:

<oem name="'OEM Name' site_ 1d="2468" ...

See Briefcase Browser site configuration files for more information about the configuration files
in the \bbworkspace\configurations directory.

9. Save the file. The configuration appears in the Configuration Name list on the Preferences dialog
box the next time you start Briefcase Browser.
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Briefcase Browser preferences

After you install and start Briefcase Browser, choose the Windows -?Preferences command to configure
or view the following settings.

-
’ Preferences I. w|slEl éj
type filter text Briefcase Browser - v -

4 Briefcase Browser

N Set Briefcase Browser preferences,

Configuration

Select the configuration or create a new configuration.

Configuration Name

default -
Site ID

Custom Mappings

Select the releaze status name from the list.

Release Status Name | TCM Released

Briefcase Companson Preferences

If applicable, choose the colors to be used when comparing briefcases for the following:
Additions:
Remowals:

Changes:

1

[ Restore Defaults l [ Apply ]

[ ok || concel |

Configuration
Displays the configuration information for the current Briefcase Browser session.
Click New to open the New Configuration dialog box. Type a configuration name and site ID

value to create a new directory under the bbworkspace\ configurations directory that contains a
site-id.properties file.

Configuration Name

Displays the list of available configurations. This list is determined by the configuration directories
that are present under the <ANY>\BB\version\bbworkspace\ configurations directory.
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The value you choose determines the supplier site configuration for the current Briefcase Browser
session.

Site ID

Displays a read-only value from the site-id.properties file for the selected configuration. It identifies
the site for write permission purposes.

Custom Mappings

Displays the list or release status names from the CustomMappings.xml file for the current
configuration.

Release Status Name

This is a read-only value list from the CustomMappings.xml file for the current configuration. This
value is used to set the release status for any new CAD parts or assemblies that Briefcase Browser
creates when saving a Briefcase file.

Briefcase Comparison Preferences

These preferences set the text colors used in the Red Line Structure view to show differences
between Briefcase files.

Startup configuration
Configure Briefcase Browser to work optimally at your site as follows.
Manage JVM memory use

Running the Briefcase Browser executable uses the Java virtual memory (JVM) properties set in the
BriefcaseBrowser.ini file. The default value for the 64-bit application is -Xmx2G, specifying a maximum
heap size of 2GB.

Modify the settings in this file to change the default JVM properties or add additional JVM properties,
such as the initial (minimum) heap size (-Xms) property.

Restart Briefcase Browser for changes in the BriefcaseBrowser.ini file to take effect.

You can temporarily override the default settings for the current Briefcase Browser session by starting
the application from a command prompt. You must have the UGII_ROOT_DIR and UGII_BASE_DIR
environment variables set and in the path. For example, to set the initial heap size to 512 MB and

the maximum heap size to 1 GB, enter the following command from the directory containing the
BriefcaseBrowser.exe file:

BriefcaseBrowser.exe -vmargs -Xmsb512m -Xmx1G

You can set the environment variables and PATH variable in a batch file, along with the executable and
the associated Java arguments, to ensure that the application starts properly.
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For more information about JVM settings, see the Oracle Command Line Reference documentation
available at https://docs.oracle.com and https://developer.ibm.com.

Optimize Briefcase Browser performance

The Java heap size affects the stability and performance of Briefcase Browser and must be set according
to the size of the Briefcase files the application must open. For best results, set the Java heap size to run
Briefcase Browser with 40 percent minimum and 70 percent maximum heap usage.

For additional information about setting appropriate heap size values, see the IBM Java Troubleshooting
documentation:

Set the Briefcase Browser locale

Ensure the Format box in the Windows Region and Language control panel dialog box is set to the
same locale as your Briefcase Browser application or to US English.

Use Briefcase Browser with CAD assemblies

To open assemblies that are created in NX 11 or later, include the path to the nxbin directory in the path
environment variable, for example:

Set path= =%UGII_BASE_DIR%;%UGI1_BASE_DIR%\nxbin;%PATH%;

Caution:

Briefcase Browser handles incomplete CAD assemblies by default. To prevent handling

of incomplete CAD assemblies and to generate error messages instead, set the
BB_CAD_VALIDATION_CHECK environment variable to TRUE. If BB_CAD_VALIDATION_CHECK is
not defined or is set to FALSE, Briefcase Browser does not generate error messages for missing
dependents in incomplete assemblies.

Assembly load option preferences

Using Briefcase Browser, you can set and manage the assembly load options required while opening a
CAD assembly. You can open a CAD assembly that is saved across different folders by setting up NX Load
Options preferences in Briefcase Browser.

After you install and start Briefcase Browser, choose Windows—-Preferences and click NX under
Briefcase Browser to configure or view the NX load option settings.
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Assembly load option preferences _

P Preferences 0 W R ] iz ]
type filter text NX oo - -
Brief B
4 Briefcase Browser Set NX preferences

MNX

Assembly Load Options

() BB Default Load Options
@ BB Custom Load Options;

Load eption file Location:

Choose NX assembly load option preference to be loaded for current BB session.

(") NX Load Options

Browse

[ Restore Defaults ] [

J

Apply l

[ 0K Cancel l

Assembly Load Options allows you to choose the NX assembly load option preference for the current
Briefcase Browser session. You can select one of the following options:

BB Default Load Option

Allows you to select the default load option defined in the Briefcase Browser application.

NX Load Options

Directs Briefcase Browser to read the environment variable values defined for NX load options in the
UGII_LOAD_OPTIONS file. If the values are not defined in this file, the default native NX load options

are considered.

BB Custom Load Options

Resets or overrides the default load options defined in Briefcase Browser or NX using a custom load
option file. Select this option, and in the Load option file Location field, enter a path or Browse to a

file with the defined custom load options.
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In this manner, you can switch to a different load option without making any changes in the NX
files. However, the changes are applicable only for the current session. To load a new assembly load
option file, start a new Briefcase Browser session and select a preference.

NX load options

Using NX Load Options, you can open an NX CAD assembly in Briefcase Browser spread across different

folders.

The load option file is a .def file containing load definitions for assembly loading in NX that are used
in Briefcase Browser. Based on the Part Versions — Load option defined in this file, Briefcase Browser
opens the CAD assembly, reads the CAD data, and writes the CAD data, as needed. A sample .def file

containing the assembly load option details is as follows:

=l load_options.def r3|

(TR S

W

You can load a CAD assembly by using NX Part Versions — Load Options in one of the three ways:

* From Folders: Allows you to set a folder from where you can load a new file or open a file each time.

LoadOptions_SearchPaths: D:\\Siemens\\NXS\\UGII...
LoadOptions_LoadComponents: load all_components
LoadOptions_LoadFully: NO

LoadCptions UseLightweightRepresentations: NO
LoadCptions LoadWAVE: NO

LoadCptions LoadWAVEParents: NONE

LoadCptions LoadSubstitution: dont_allow substitution
LoadCptions LoadLatest: NO

LoadOptions LoadOption: load from dir

LoadOptions ManagedModeLoadCOption: load by revision rule
LoadOptions LoadFilters: load no components

LoadOptions LoadFailOption: dont abort

LoadOptions ReferenceSets: "As Saved" "Entire Part" "Empty" "Use Model"
LoadOptions ApplyAllLevels: NO

LoadOptions GenerateMissingPFM: YES

LoadOptions BookmarkRefSets: Import
LoadOptions_BookmarkPartsLoad: Load Visible
LoadOptions_BookmarkRestoreFullyloadedState: no
LoadOptions_SubsetloadBehavior: Do_Not_Update

This the NX Part Versions default load option.

* As Saved: Allows you to set the path to the folder where the file is saved. Once set, you are redirected

to that folder each time you open a new file.

* From Search Folders: Allows you to load an assembly for which the parts are saved in different
folders. This load option file will contain information about all the folders where the assembly part

files are saved.
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Briefcase Browser site configuration files

Briefcase Browser reads the XML configuration files in the bbworkspace\configurations directory. Each
configuration has a separate directory that contains the site-id.properties file as a minimum.

The create_briefcase_browser_config_package utility creates a compressed package file of the
configuration files that you can provide to your suppliers. The utility takes the path to the Briefcase
Browser installation ZIP file (-bbDir argument) and generates a managed (OEM) site ZIP file containing
the OEM configuration package.

create_briefcase browser_config_package -u=username -p=passwd -g=dba
-bbDir=C:\apps\bb

The package name is the OEM site name. It contains the CustomMappings.xml file with the OEM site
ID set as the target site ID. It also contains the TCXML.xsd schema file, generated from the OEM and the
OEM configuration file.

site-id.properties

Defines the unmanaged site ID. This value can be any numeric sequence not starting with a zero and
is not required to meet Teamcenter site ID requirements. If this file is not present, Briefcase Browser
does not allow you to create a Briefcase file. You can create or modify this file manually or use the
Preference dialog box in Briefcase Browser.

It must also contain the following additional configuration files:

TCXML.xsd

Defines the schema that Briefcase Browser uses to load, display, and create Briefcase files. This file is
typically supplied by the managed (OEM) site to the supplier (unmanaged) site. It is available in the
TC_DATA directory of the Teamcenter installation.

If a TCXML.xsd file does not exist in the configuration directory for your site, Briefcase Browser
uses the standard Teamcenter schema. TCXML.xsd is required in this directory for comparing and
previewing Briefcase files.

Note:

The uniform resources identifiers (URIs) that appear in the headers of PLM XML and TC XML
files serve as namespace names, are unique identifiers for an XML vocabulary. Although they
are URIs, they are not used to identify and retrieve web addresses.

CustomMappings.xml

Defines the following information about the Teamcenter (OEM) site with which you exchange
Briefcase files:

¢ The site name.
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The site ID.
The Teamcenter version.

If your site must use the auto_baseline (baseline) feature when exchanging updated Briefcase
data.

If the site allows precise or imprecise structures.

If your site must create all replica objects as stubs (include_all_objects=false). When writing
reference objects as stubs, Briefcase Browser does not package any corresponding CAD data in
the Briefcase package. If this value is set to true, Briefcase Browser writes all objects as full objects
in the Briefcase file reference replica parts.

If your site must include full objects for all checked-out parts and locally owned parts
(include_modified_objects_only=false). If this value is set to true, Briefcase Browser writes local
parts as full objects. Parts checked out to your site as full objects are also written as full objects if
they are modified since the file was last saved, including their parent and grandparent objects. If
objects checked out to your site have not been modified, they are written as stub objects and the
corresponding part files are not included in the Briefcase package.

The separator character the site requires between the item ID and revision.
Custom type mapping to OEM objects.

Release status values the managed (OEM) site allows you to assign to parts or assemblies that
you create in the release_status_name elements. Briefcase Browser displays the values that you
supply in release_status_name elements in the Release Status Name list in the Preferences
dialog box. The value you select in the Preferences dialog box is assigned as the release status of
any new CAD parts or assemblies you create. The value must match one of the valid values for the
Teamcenter release status at the OEM site.

Custom forms related to item revisions to process when exchanging data, such as business
object forms with mass-related properties. When ir_to_form is set to true, the listed forms are
processed. If ir_to_form is set to false, the forms are ignored. See the ir_to_form section in the
following sample for examples.

mple content for this file:

<?xml version="1.0" encoding="UTF-8"7?>
<custom_mappings xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
xsi:noNamespaceSchemalLocation="_./bce-core/CustomMappings.xsd'>
<oem name="'your_oem_name" site_id="87654321" tc_version="Target-TC-Version"
auto_baseline="false" generate_validation_xml="false" is_precise="true"
separator="/" object_name_separator="/" bomview_type_name="'view"
include_modified_objects_only="false" include_all_objects="false"
extract_to_sub_directory="false" process_reference_briefcases="true'">
<release_status_name>Snapshot</release_status_name>
<release_status_name>TCM Released</release_status_name>
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<release_status_name>R2InWork</release_status_name>
</oem>

<ir_to_form enabled="false">
<form_type>custom_form_type</form_type>
<relation>custom_relation</relation>
</ir_to_form>

<item_type_mapping custom_type=""ltem">
<multi_field_key>
<attribute>item_id</attribute>
</multi_Ffield_key>
<helper_object_map custom_type="IltemRevision"
ooth_type="IltemRevision"/>
<helper_object_map custom_type="Iltem--Master"
oothb_type="Iltem--Master"/>
<helper_object _map custom_type=""ltemRevision--Master™
ooth_type="ItemRevision--Master"/>
</item_type_mapping>

<item_type_mapping custom_type=""CAD">
<multi_field_key>
<attribute>item_id</attribute>
</multi_Ffield_key>
<helper_object _map custom_type="CAD--Revision"
ootb_type="IltemRevision"/>
<helper_object _map custom_type="CAD--Master"
ootb_type=""Item--Master"/>
<helper_object _map custom_type="CAD--Revision--Master"
ootb_type="IltemRevision--Master"/>
</item_type_mapping>

<item_type_mapping custom_type="B4ltem'>
<multi_field_key>
<attribute>item_id</attribute>

</multi_Ffield_key>

<helper_object _map custom_type=""B4ltemRevision"
ootb_type="IltemRevision"/>

<helper_object_map custom_type="B4ltemMaster™
ootb_type=""ltem--Master"/>

<helper_object _map custom_type=""B4ltemRevisionMaster™
ootb_type="IltemRevision--Master"/>

/item_type_mapping>

<item_type_mapping custom_type="CommercialPart'>
<multi_field_key>
<attribute>item_id</attribute>
</multi_Ffield_key>
<helper_object _map custom_type="CommercialPart--Revision"
ootb_type="ltemRevision"/>
<helper_object _map custom_type="CommercialPart--Master"
ootb_type=""Item--Master"/>
<helper_object _map custom_type=""CommercialPart--Revision--Master"
ootb_type="IltemRevision--Master"/>
</item_type_mapping>

<item_type_mapping custom_type="Design'>
<multi_field_key>
<attribute>item_id</attribute>
</multi_Ffield_key>
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<helper_object _map custom_type="Design--Revision"
ootb_type="IltemRevision"/>
<helper_object _map custom_type="Design--Master"
ootb_type=""ltem--Master'/>
<helper_object _map custom_type="Design--Revision--Master"
ootb_type="IltemRevision--Master"/>
</item_type_mapping>

<item_type_mapping custom_type="Part'>
<multi_field_key>
<attribute>item_id</attribute>
</multi_Ffield_key>
<helper_object _map custom_type="Part--Revision"
ootb_type="IltemRevision"/>
<helper_object_map custom_type="Part--Master™
ootb_type=""ltem--Master"/>
<helper_object _map custom_type="Part--Revision--Master"
ootb_type="IltemRevision--Master"'/>
</item_type_mapping>
</custom_mappings>

The auto_baseline attribute indicates whether or not your Briefcase Browser provides autobaseline
functionality. If this is set to true, the baseline feature is enabled. The template file has this value set
to true. If it is set to false, Briefcase Browser does not automatically revision objects. If the attribute
is not defined in this file, Briefcase Browser performs automatic revisions as if the attribute was set to
true.

If the Briefcase file you are exchanging must contain precise assembly structures, set the is_precise
attribute to true. Set this value to false when imprecise assembly structures are allowed.

If you intend to add objects to CAD parts in the CAD application, set the include_all_objects
attribute to true to include them when you save the Briefcase file for exporting back to Teamcenter.

You can have any number of release status elements. These become the selection list for Release
Status in your Briefcase Browser Preferences dialog box.

You map custom CAD parts types to OEM types by assigning a custom Item type to the items in the
TC XML data created for your CAD part. You define the subtype of the Item type as a helper object,
for example:

<helper_object_map custom_type="CADPart" ootb_type="Item"/>

This causes the TC XML data generated for custom CADPart supplier owned parts to be created as
Item objects at the OEM site.

Note:

The custom item type must be defined in the schema (TCXML.xsd) file used by Briefcase
Browser.
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You can have multiple custom types defined in this file. Briefcase Browser locates the matching
custom type in the file and maps the file to the defined OEM object. If a custom type part is not
found in the CustomMappings.xml file, the first custom type defined is used. If there are no custom
types defined, Briefcase Browser maps the part to the standard Teamcenter type.

CustomDatasetMappings.xml

This XML file contains valid dataset extensions and relation types supported for Non-CAD files. Each
dataset extension specifies whether it is a primary (master), dataset name, ref_names, and relation
to be used while generating TC XML. Each relation type specifies the display relation for the Add
Dataset dialog box and the actual relation to be used for generating TC XML. If this file is not found,
an OQTB file is used. You can add additional non-CAD types to this file.

Caution:

If your system has CAD dataset types other than the primary dataset, and the dataset type
follows the model file naming convention, you must add an entry representing the dataset.
Add the entry with the is_master attribute set to False, for example:

<cad_data_set_mapping is_master="False" dataset_type=""UGPART"
ref_names="UGPART" relation=""/>

This prevents an error from occurring when you open or synchronize an updated CAD
assembly in Briefcase Browser.

<?xml version="1.0" encoding="utf-8"7?>

<I-- XML file containing valid dataset extensions and relation types supported for
Non-CAD files.

Each dataset extension specifies if it is a master, dataset name, ref_names and
relation to be

used while generating TCXML. Each relation type specifies the display relation for
the Add Dataset

dialog and the actual relation to be used for generating

TCXML. -->
<custom_data_set _mapping xmlns:xs="http://www.w3.0rg/2001/XMLSchema"
xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance">

<data_set_mapping extension="prt'>

<cad_data_set_mapping is_master="True" dataset_type="UGMASTER" ref_names="UGPART"
relation="""/>

<cad_data_set_mapping dataset_type="UGPART" ref_names="UGPART" relation="""/>

</data_set_mapping>
<data_set_mapping extension="‘doc'>
<cad_data_set_mapping dataset_type="MSWord" ref_names="word"
relation="IMAN_reference'/>

</data_set_mapping>
<data_set_mapping extension="‘docx'>
<cad_data_set_mapping dataset_type="MSWord" ref_names="word"
relation="""/>

</data_set_mapping>
<data_set_mapping extension="xls">
<cad_data_set_mapping dataset_type="MSExcel" ref_names="excel"
relation="""/>

</data_set_mapping>
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<data_set_mapping extension="jpg'">
<cad_data_set_mapping dataset_ type="JPEG" ref_names="JPEG_Reference"
relation="""/>
</data_set_mapping>
<data_set_mapping extension=""jt">
<cad_data_set_mapping dataset_type="DirectModel" ref_names="JTPART"
relation="IMAN_Rendering'/>
</data_set_mapping>
<relation_type actual_relation="IMAN_specification”
display_relation="specification"/>
<relation_type actual_relation="IMAN_Rendering"
display_relation="rendering"/>
<relation_type actual_relation="IMAN_manifestation"
display_relation="manifestation"/>
<relation_type actual_relation="IMAN_reference"
display_relation="reference"/>
</custom_data_set_mapping>

cad_to_tc_attribute_map.xml

Defines the mapping of user-defined NX attributes to qualified Teamcenter object attributes. The
user-defined attributes must be part of the configured TC XML schema (TCXML.xsd file). This allows
you to define attributes for qualified objects in addition to the required attributes.

Caution:

You can map only one CAD part attribute to one Teamcenter attribute (1-to-1 map). Mapping
a CAD part attribute to multiple Teamcenter attributes or a single attribute to multiple item
types can corrupt or lost data.

Example:

<?xml version="1.0" encoding="UTF-8"7?>

<I-- Only one CAD2TC_attribute _mappings that can contain more than one
attribute map. These mappings will hold a list of CAD attributes
that map to teamcenter attribute -->

<CAD2TC_attribute_mappings xmIns:xsi="http://www.w3.0rg/2001/XMLSchema-instance""
xsi:noNamespaceSchemalocation=""cad_to_tc_attribute_map.xsd">

<l-- cad_part_attr should be unique for each attribute_mapping -->

<attribute_mapping cad_part_attr="PART_MATERIAL" tc_attr="nisPartMaterial”
tc_type="CAD--Revision--Master"/>

<attribute_mapping cad_part_attr="PART_THICKNESS" tc_attr="nisPartThickness"
tc_type="CAD--Revision--Master"/>

<attribute_mapping cad_part_attr="CALC_WEIGHT" tc_attr="nisCalculationWeight"
tc_type="CAD--Revision--Master"/>

<attribute_mapping cad_part_attr="CALCULATIVE_COEFFICIENT"
tc_attr="nisCalculativeCoefficient"”
tc_type="CAD--Revision--Master"/>

<attribute_mapping cad_part_attr="Z_CENTROID" tc_attr="nisGravityZ"
tc_type=""ltemRevision--Master'/>

<attribute_mapping cad_part_attr="Y_CENTROID" tc_attr="nisGravityY"
tc_type="CAD--Revision--Master"/>

<attribute_mapping cad_part_attr="X_CENTROID" tc_attr="nisGravityX"
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tc_type=""CAD--Revision--Master"/>
</CAD2TC_attribute_mappings>

visible-attributes.xml

Defines the attributes that are displayed in Briefcase Browser properties views. By default, Briefcase
Browser displays all qualified attributes. If this file is present, Briefcase Browser limits the attributes in
the properties views to the attributes defined in this file. The following is sample content for this file:

<visible_attributes>

<group name="ltem">
<attribute ootb_type="Item" name="item_id"/>
<attribute ootb_type="ItemRevision" name="object_name'/>
<attribute ootb_type="ItemRevision”
name=""object_description'/>
</group>

<group name="*Admin’'>
<attribute ootb_type="POM_imc' name="POM_imc"/>
<attribute ootb_type="Group'™ name="Group'/>
<attribute ootb_type="'User'" name="User'/>
</group>

</visible_attributes>
attributes_text_locale.xml

Defines the localized values for the language indicated by the name of the directory containing the
file. The directory name consists of a two-character locale and two-character country code such as
en_US. The language directories must be in the lang directory in the site’s configuration directory.

For example, the following shows the US English (en_US) and the Japanese localization (ja_JP)
directories:

= [ configurations
=1 default
= = dashboard_supplier
- = lang
= en_US
= ja_JP
Briefcase Browser reads the TC XML file content and displays the object property names as defined in
the file. The properties are database field names that may not be readable by your users. You can use

this file to map the database field names to usable localized names.

Your attributes_text_locale.xml files must be UTF-8 encoded. They must also contain the following
element as the root XML element in the file:

<?xml version="1.0" encoding="UTF-8" standalone="yes"'?>
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If the property names are not displayed in your locale language, use a different text editor for UTF-8

encoding.

Following is sample content for this file in the Japanese locale:

<?xm] version="1.0" encoding="UTF-E8" standalone="yes"7>
<textarv filename="attributes_text locale.xml™>

<key id="inbox type">EE kL A</ key>

<key id="inbox_name_1">BITRAT</ key>

<key id="inbox name 2">EEFEAT</key>

<key id="type_label" > F</ key>

<key id="object lebel">F TV LU h</key>

<key id=“property_lahel")—?'l],lfj_v- A4 ke

<key id="mag string">7 A NABLHEEEFEDM A </ key>

<!-—-generic_shell.cxx-->
<key id="shell string">0bjectListBox Shell</key>

<!-—gkjectlistbox.cxx—->

<key id="ownerid_string">FIEEID< key>

<key id="date string"EEB</key>

<key id="cannot_string">RiAE ) </ kev>

<key id="readOnlyMsg">ZAETR</ kev>

<key id="spp_encapsulation_label">F FUT —Z 3 B{#l</ key>
<l——tool.cux——>

<l-—distributionlist.cix envelope.cxx-->
<key id=“mail_label"})( — </ key>

<!-——form.cEx——>
<key id="form_def label">7#—LERTF 1 ILE</ key>
<key id="structure group label">EE7 I —7 < /keyv>

<! --bomview.cxx-—->

<key id="bomview_label™>BOME 1 —</key>
<key id="product label">H W</ key>

<key 1d="F3M label"»P3M</key>

<key id="item_id_string">F- T LID</ key>
<key id="dataset id">T—HEY hID</ key>

<!--1 <M5F> 04-Mar-1994 Workspace coclumn headings - the xxx names are used-->

<!--! for backward compatibility with existing .tc_env files-->
<key id="private_obiect_string" scope="private">F T I T b ke
<key id="private_id lahel™ scope="private">ID:/ key>

<!-- Part Object -->

<key id="is designrequired">T 4 I Erd R/ kev>
<key id="make_or_buy">BhE/BR</ keyv>

<key id="part make">Fhf</ key>

<key id="part_buy">BR</ key>

Alrextarvy
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Sample files are provided for each of these configuration files in the
example\bbworkspace\configurations\example directory.
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4. Using Briefcase Browser

Starting Briefcase Browser

1.

After you install and configure Briefcase Browser, start it by double-clicking the Briefcase Browser
program file:

bb_install_path\BB\BB_version\BriefcaseBrowser .exe
Choose Window - Preferences.
Choose the configuration of the site with which you are sharing data. Click Apply and Close.
See Briefcase Browser preferences for additional information on Briefcase Browser preferences.

Caution:

If you are working with NX parts or assemblies in a Briefcase file, including creating a new
Briefcase file, the part or assembly must not be open in the CAD application or any other
application that can create a lock on the associated file. The Briefcase Browser Save Briefcase
and Synchronize commands do not function as intended if a file is locked by another application.
This can cause data inconsistencies in the generated Briefcase file.

Briefcase Browser documentation

View Briefcase Browser documentation by choosing Help Contents from the Help menu. Briefcase
Browser documentation is also available in PDF format:

bb_install_path\BB\BB_version\docs\Teamcenter_Briefcase Browser_Guide.pdf

Opening and working with Briefcase files

You can open Briefcase files to perform several actions, including:

Adding new local supplier parts.

Changing existing supplier parts in the structure.

Adding a local supplier top assembly to an OEM supplied structure.
Making a CAD assembly complete.

Building a component structure.

Previewing a structure.

To open a Briefcase file that was exported to your site from a managed site or a file you created:
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Choose File-»Open Briefcase. Alternatively, you can click the open Briefcase button gl on the
toolbar.

In the Select a file representing the briefcase dialog box, browse to the file location and click
Open.

In the Open Briefcase File dialog box, click Choose File, browse to the desired Briefcase file, and
click Open.

If you are opening a Briefcase file that contains delta NX assembly data, check Specify different
working directory, set the working directory to the directory that contains the original Briefcase
contents, and click OK.

If you are opening a Briefcase file and wish to retrieve any changes made to existing CAD parts
that are owned by your site, check Specify different working directory, browse to the working
directory, and click OK.

Otherwise, click OK and the directory containing the Briefcase file becomes the working directory.

Briefcase Browser displays the selected Briefcase file structure in the Existing Structure tab of the
structure view.

Warning:

The working directory can be a remote directory. However, if there are multiple Briefcase
Browser users in your organization, multiple users using the same working directory at the
same time can result in a corrupt or invalid Briefcase file. To avoid this, ensure that you use
different working directories or that users do not use the same working directory at the same
time.

(Optional.) Click the Controls/Properties tab to view the schema used for the current
configuration. You can also click View on this tab to browse the contents of the current working
directory.

(Optional.) Double-click the name tab at the top of the structure view to minimize all other views
and expand the structure view to the entire size of perspective. Right-click the tab and choose
Restore to restore the original view.

Working with Briefcase files containing NX data

The Briefcase file may contain incomplete CAD assemblies, partial BOM assemblies, delta BOM
assemblies, or variant configured assemblies.

With the Briefcase file open, select an item that has a CAD dataset attached and choose
Tools—>Launch NX.

Briefcase Browser starts NX and loads the CAD data.
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Open a CAD file (create a new CAD object) _

2. In NX, add local parts to the assembly or add OEM owned parts to a local assembly and save the
changes.

3. Synchronize the file to get the modified CAD data into the Briefcase file.
Choose Tools=Synchronize or click the synchronize button 3.

4. In Briefcase Browser, choose File—>Save Briefcase to update the Briefcase file with the CAD
changes and required Teamcenter TC XML data.

Working with Briefcase files containing CATIA data

1. With the Briefcase file open, select an item that has a CAD dataset attached and choose
Tools—>View in CATIA.

Briefcase Browser starts CATIA and loads the CAD data.

2. In CATIA, add local parts to the assembly or add OEM owned parts to a local assembly and save the
changes.

3. You must synchronize the file to get the modified CAD data into the Briefcase file.
Choose Tools=Synchronize Briefcase or click the synchronize Briefcase button &.

4. In Briefcase Browser, choose File—>Save Briefcase to update the Briefcase file with the CAD
changes and required Teamcenter TC XML data.

Open a CAD file (create a new CAD object)

You can create a Briefcase file based on a CAD assembly or part. Briefcase Browser creates the required
TC XML data to provide a valid Briefcase file. Briefcase Browser also validates the CAD file meets certain
requirements and provides an error report if the requirements are not met. Briefcase Browser does not
load files that are not valid.

1. Choose File»Open CAD Assembly. Alternatively, you can click the Open CAD Assembly button
+, on the toolbar.

2. Click Choose File and navigate to the desired CAD part (prt) file and click Open.

Briefcase Browser loads the CAD file into the Existing Structure tab and creates the required TC
XML data including the objects, required attributes, and structure. The path and file name are
shown at the top tabs of the structure view.

Briefcase Browser displays an error report if the file does not pass validation.
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Briefcase Browser

Improper comvention followed.
File Mame Expecied File Name
000099 _& prt 000099 _C prt

3. Choose File=>Save Briefcase to save the structure as a Briefcase file.

Note:

Briefcase Browser sets the release status for all new CAD parts or assemblies to the value you
select in Release status name list of the Preferences dialog. If you want to use a different
value, select the a new value from the list before you save the Briefcase file.

Add non-CAD files to a modifiable part

After opening a Briefcase, you can attach non-CAD files such as Microsoft Word or JT to a modifiable part
in a CAD assembly.
Caution:

Briefcase Browser uses a CAD part naming convention to identify NX drawing files. The use of _s_
or _m_in a file name denotes an NX drawing. Therefore, non-CAD files must not contain the _s_ or
_m_ character sequences in the file name.

Additionally, you cannot add the same file as a dataset to two different objects as the global stable
identifier for each is different but the file name is the same. This causes an import error when the
file is imported to Teamcenter. To avoid this, add the dataset to the first object, save and close
Briefcase Browser. Reopen Briefcase Browser to start a new session and add the file to the second
object. This allows a different file name for the dataset in the second session.

1. Choose File=»Open CAD Assembly. Alternatively, you can click the #, button on the toolbar.

2. Inthe Existing Structure tab of the structure view, select the part to which you want to attach
non-CAD files. A non-CAD file can be added to any modifiable part (site-checked out parts or
supplier parts).

3. You can attach non-CAD files in three ways:
¢ From the Tools menu, select Add Dataset.
* From the toolbar, click 4.

* Right-click the local part, to open the context menu Add Dataset.
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4. Inthe Select the non-CAD file dialog box, browse to the desired non-CAD file, and click Open.

5. Inthe Add Dataset dialog box, select the Relationship Name from the list to associate it with the
non-CAD file. Click OK to add the file to the part.

The relationship name is populated if it is specified in the CustomDatasetMappings.xml file.
However, you can change the default relationship name if no relationship is specified, or you can
choose a different relationship.

You can add the file only if the selected file has a valid file extension (defined in the
CustomDatasetMappings.xml file). If not defined, the OK button is disabled.

6. Non-CAD files can also be added to a modifiable part automatically that follow naming convention.
While opening a CAD assembly, if there are any non-CAD files that match any modifiable parts
in the assembly with valid extensions defined in the CustomDataMappings.xml file, appropriate
datasets are created and attached to the modifiable part.

7. The new dataset and the relationship is added to the Dataset view of the part. To view the file
added as the dataset, expand the dataset, select the file, and double-click to open the file in the
respective editor.

8.  Once the non-CAD files are attached to the CAD files, you must synchronize the file to get
the modified CAD data into the Briefcase file. If the changes are restricted to non-CAD files,
synchronization is not required.

For Briefcase files containing NX data, choose Tools=>Synchronize or click the synchronize button

-

-

For Briefcase files containing CATIA data, choose Tools-?»Synchronize Briefcase or click the
synchronize Briefcase button @.

9. Click [z to save the file. Alternatively, you can choose File-»Save Briefcase.

The saved Briefcase will contain non-CAD datasets attached to the modifiable parts that are sent to
the managed sites to be imported into Teamcenter.

Remove non-CAD files from a modifiable part

To remove non-CAD files from the modifiable parts, in the Dataset view, select the file and click Delete

The Non-CAD dataset is removed from the part. The saved Briefcase does not contain datasets, data files,
and relations specific to deleted datasets.
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Note:

For Briefcase files containing NX data, the UGMaster object cannot be deleted using this option.
Only non-CAD files attached to the UGMaster object can be deleted.

Compare Briefcase files

You can compare two Briefcase files and display the differences in the Red Line Structure tab in the
structure view. Briefcase Browser displays deleted objects in red and added objects in green in this tab.

1.

If you do not have one of the Briefcase files being compared open, choose File->Open Briefcase,
and select the first file. Briefcase Browser loads this file into the Existing Structure tab of the
structure view.

Choose Tools=»Compare the briefcase to another briefcase, and select the file you want to
compare.

Briefcase Browser loads this file into an Proposed Structure tab of the structure view and displays
the differences in the Red Line Structure tab. Objects added, removed, and changed in the
proposed structure are displayed in different text colors in the Red Line Structure tab as defined by
the Briefcase comparison preferences in the Preferences dialog box.

You can also use the compare button gion the Controls/Properties tab to load the file to compare.

Modify NX data in a Briefcase file

1.

Start Briefcase Browser, choose File=»Open Briefcase, and select the Briefcase file that contains
the CAD data to be modified.

In the Existing Structure tab of the structure view, select the object that you want to modify. Your
site must own the object, and it must not be checked out to a remote site. This is indicated by the
local item revision symbol .

Alternatively, you can choose Tools=Launch to open the CAD object in NX.

The Briefcase file must be saved if it was created in Briefcase Browser.

After you edit the object in NX and save it, select the object name tab in the Existing Structure tab
of the structure view click the synchronize button 3.

Caution:

When adding existing parts to an assembly in NX, you must use the Add Component
command. If you copy and paste the part to create a new occurrence, the synchronize action
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in Briefcase Browser does not create a unique occurrence. This causes an import error when
you attempt to import the Briefcase package into Teamcenter.

4.  Click the save Briefcase button [] to save the file. Alternatively, you can choose File-»Save
Briefcase.

The modified NX data is saved to the Briefcase file that can now be sent to the managed site to be
imported into Teamcenter.

Modify CATIA data in a Briefcase file

1.  Start Briefcase Browser, choose File=»Open Briefcase, and select the Briefcase file that contains
the CAD data to be modified.

2. Inthe Existing Structure tab of the structure view, select the object that you want to modify. Your
site must own the object, and it must not be checked out to a remote site. This is indicated by the
local item revision icon (#%).

Alternatively, you can choose Tools=>Launch to open the CAD object in CATIA.

The Briefcase file must be saved if it was created in Briefcase Browser.

3. After you edit the object in CATIA and save it, select the object name tab in the Existing Structure
tab of the structure view click the synchronize button @.

4.  Click the save Briefcase button [] to save the file. Alternatively, you can choose File-»Save
Briefcase.

The modified CATIA data is saved to the Briefcase file that can now be sent to the managed site to
be imported into Teamcenter.

Modify JT data in a Briefcase file

When you have the Briefcase Browser JT plugin installed, you can open and update JT files supplied
to you in Briefcase files. When existing JT files are not delivered in the Briefcase file, Briefcase Browser
automatically creates component and assembly JT files based on the contents of the Briefcase file. You
can open and edit these empty JT files to supply CAD data to the managed site.

For example, a managed site creates the following structure:

TopNode_A
| __SubAssembly A
| __compl A
| __comp2_A
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| _SubAssemblyl A
| _comp3_A

The managed site then exports the structure to a Briefcase file, granting ownership to the unmanaged
site. When the unmanaged site opens the Briefcase file using Briefcase Browser with the JT plugin
installed, the following component JT objects are created in the working directory:

* comp1_A.jt

* comp2 A.jt

e comp3 A.jt

The following assembly JT objects are created in the working directory:
* TopNode A.jt

* SubAssembly A.jt

* SubAssembly1 A.jt

Use the following process to edit the JT files in your CAD software and return the updated JT objects to
the managed site.

1.  Start Briefcase Browser, choose File=»Open Briefcase, and select the Briefcase file that contains
the JT data to be modified.

The Open Briefcase File dialog box is displayed.
2. Check Specify different working directory, browse to the working directory, and click OK.

3. When the Briefcase file opens in Briefcase Browser, the Briefcase contents are saved in the working
directory.

In the working directory, locate the JT objects you wish to update.

4. Use your existing translator utilities to convert the JT objects to your CAD software file format. Your
site must own the objects, and they must not be checked out to a remote site. This is indicated by
the local item revision icon (7).

Update the converted files using your CAD software.

5. When you have completed editing the CAD files, use your existing translator utilities to convert the
CAD files to JT objects.
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Ensure the translated JT objects are saved with the same file names as the JT objects created by
Briefcase Browser.

If you saved the newly-translated JT objects in another directory, copy them to the working
directory specified earlier in this procedure, overwriting the original JT objects.

6. In Briefcase Browser, select the object name tab in the Existing Structure tab of the structure view
click Synchronize &@.

7. Choose File->Save Briefcase to save the Briefcase file.

The modified JT data is saved to the Briefcase file. You can now send the Briefcase file to the
managed site to be imported into Teamcenter.

Synchronize CAD data

Modified CAD data must be synchronized with the Briefcase file to include the modified data in the file.
Use the following procedures to synchronize your type of modified CAD data.

Synchronize NX data

1. Ensure the tab for the Briefcase file that has modified NX objects is selected in the Existing
Structure tab of the structure view.

2. Choose Tools=Synchronize or click the synchronize button 3.

Briefcase Browser updates the CAD data in the Briefcase file with the modified CAD data. You
must save the Briefcase file (File->Save Briefcase) before closing it or exiting Briefcase Browser to
maintain the updated CAD data in the Briefcase file. If there are any non-CAD files in the working
directory with the same base file name, they are added to respective parts.

Synchronize CATIA data

1.  Start Briefcase Browser, choose File=»Open Briefcase, and select the Briefcase file that contains
the CAD data to be modified.

2. Inthe Existing Structure tab of the structure view, select the object that you want to modify. Your
site must own the object, and it must not be checked out to a remote site. This is indicated by the
local item revision icon (#%).

Alternatively, you can choose Tools=>Launch to open the CAD object in CATIA.

The Briefcase file must be saved if it was created in Briefcase Browser.

3. After you edit the object in CATIA and save it, select the object name tab in the Existing Structure
tab of the structure view click the synchronize Briefcase button &@.

4-9



4. Using Briefcase Browser

4. Click the save Briefcase button [] to save the file. Alternatively, you can choose File-»Save
Briefcase.

The modified CATIA data is saved to the Briefcase file that can now be sent to the managed site to
be imported into Teamcenter.

Transfer ownership of local parts

1.  Start Briefcase Browser, choose File=»Open CAD Assembly, and select the Briefcase file that
contains the local parts owned by you.

2. Inthe Existing Structure tab of the structure view, select the parts that you want to mark for

ownership transfer. Your site must own the part, and it must not be checked out to a remote site.

This is indicated by the local item revision symbol .

3. Right-click a local part to open the context menu Mark for Ownership Transfer.

& D ir\bb_new\ OTTest\data\16F3nov_valve_partial_assembly_c A_Aprt &
Part Number Name Description Revision CAD Attached T Attached  Read Only
4 % 16F3nov_valve_partial_assembly_c_A 16F3nov_valve_partial_assembly_c_A 16F3nov_valve_partial_asse.. A v

% 16F3nov_valve_cover_bolt c A 16F3nov_valve_cover_bolt c A 16F3nov_valve_cover_bolt c.. A ¥
“ 16F3nov_valve_cover_bolt_c_A 16F3nov_valve_cover_bolt_c_A 16F3nov_valve_cover_bolt c.. A ¥
“ 16F3nov_valve_cover_bolt_c_A 16F3nov_valve_cover_bolt_c_A 16F3nov_valve_cover_bolt_c.. A v
% 16F3nov_valve_shaft_bolt_c A 16F3nov_valve_shaft_bolt_c A 16F3nov_valve_shaft_bolt c.. A v
% 16F3nov_valve_shaft_bolt c A 16F3nov_valve shaft_bolt c A 16F3nov_valve_shaft bolt c.. A ¥
% 16F3nov valve € A | . Mark for Ownership Transfer 16F3nov_valve_c_A A 4
4 % 16F3nov_valve_vendd ‘%, Add Dataset or_subassembly_c... 16F3nov_valve_vendor_sub.. A v
% 16F3nov_valve_shaft c A 16F3nov_valve_shaft c A 16F3nov_valve_shaft c A A v

% 16F3nov_valve_arm_c A 16F3nov_valve_arm_c A 16F3nov_valve_arm_c_A A ¥

% 16F3nov_valve_cover_c_A 16F3nov_valve_cover_c_A 16F3nov_valve_cover ¢ A A v

% 16F3nov_valve_key_c_A 16F3nov_valve_key_c_A 16F3nov_valve_key_c_A A v

“ 16F3nov_valve_shaft_nut c A 16F3nov_valve_shaft_nut_c A 16F3nov_valve_shaft nut c A A v

» % 16F3nov_valve_rodunit_subassembly_¢ 16F3nov_valve_rodunit_subassembly_c.. 16F3nov_valve_rodunit_sub.. A v
* 16F3nov_valve_housing_c_A 16F3nov_valve_housing_c A 16F3nov_valve_housing ¢ A A v

The parts marked for ownership transfer will then be listed in the Ownership Transfer view. Once
the part is marked for ownership transfer, the icon for that part changes to

B Brieicase Browser = s =
File: Toals Window  Help
#HlEEe ¥ D6l TEAMCENTER _ SIEMENS
e irlob. one\OTT valve_partia assembly < AApH % =0 £ liem Propertes == [ il
Part Number Neme: Description Revision CAD Attached JT Attached  Read Only Propery. UL
+ B 16F3nov.valve_periial assembly_c A 16F3now valve.partial asse... 16F3nov.valve partial asse.. A v 4 Admin
% 167300V valve_Cover_boltCA 16F3n0w_valve._cover_bolt.c.. 16F3nov_valve_cover bolt c. A v FOM Jmc 1248
% 16¢3nou valve cover blt ¢ A 16F2nov.valve cover bolt c.. 16¢3noy valve cover boll . A . L
% 1673nov_valve cover_bolt A 16F3nou valve. cover_bol c... 1673nov_valve_cover_bolt_c. A v ftem ID: 16730 valve € A
% 16F3nov_valve_shaft_bolt_c A 16F3nav_valve,shaft_bolLc 16F3nor_vaive shafibolt_c.. A v Object Name 1663n0v valve.c A
now valve,shaft Bolt.c A 16Finv,valve shaft_bolt.c. 16¢3nov valve shalt bolt c.. A v
R o 16F3nov_valve_c A 16F3nov valve < A A v
OVYY 5 Aid Dataset 167300 valve. vensor_sub... 16FIn0V_Valve vendar sub.. A v
% 16F2n0v-vaes e 16Fnovvale shaft e A 16FInovvave shalt A A v
% 1630w valve arm ¢ A I6Fnovvalveam e A 1680w alve am A A v
% 16F3nov_valve_cover_c A 16F3nay valve cover.c A 16Fnouvalve coverc A A v
% 16F2n0n_valve key_c A 16Finovvalve key.c A 16FnouvalvelercA A v
% 16F3n0v.valve,shaft_nut c A 16F3now valve: shaft nut ¢ A 16F3nov.valve shaft nut c A A v
4 16F3n0v.valve._fodunit Subassembly_c A 16F3n0v.valve SoBUNIL 5., 167 3n0u Valve rodunit sub, A v —
% L6k3nov valve redend « A 16F2nov.valve rodend e A 1663nov valve rodend c A A v Al Dedasclf] L
2+ 16F3n0v.valve_trod_nutbolt subassembly A 16F3nov valve 1rod nutbalt v v Name Description  Type Relationship Na__
167 3now valve,_ierod_bolt.c A 16F3nav_valve tierad_bolr_. v v 5 16FInov valve c A/A  16F2now,val_ UGMASTER  specification
2 166300 valve_housing_put_c A 16Finav,valve,housing v v
% 16F3nov valve._hausing_c A 16F3naw valve. housing < A v
ype filter 1B
Part Number Name Description
E—— 1673n01_valve_partial_assembiy_c. 16%3nov_valve_partia asse. 16F3nov.valve parial_
— 1630w valve < A 1673nov_valve_c.A 16F3nav_valve_c A
@ EnorLag & Rl

Workspace Log
type filter text

Message Plug-in Date
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Transfer ownership of local parts _

Alternatively, you can also mark parts for ownership transfer from the Ownership Transfer dialog
box.

Click Tools=Transfer Ownership to open the Ownership Transfer dialog box. Alternatively, select
Ownership Transfer from the toolbar button.

The parts listed in the Ownership Transfer dialog box depends on what is selected in the Existing

Structure view. If no parts are selected in the Existing Structure view, all the parts are listed in the
Ownership Transfer dialog box. If a given sub assembly is selected, then all local parts of that sub

assembly are listed in the Ownership Transfer dialog box.

Property Value
Part Number Name pr—
Ownershi =) £3 P
16F3noy jal_assembly.c.A  16F3nov_valve_partial_assembly.c. [ iy lciol ‘j Admin
. )
» 1663 tcA 16F3nov_valve_ct -/ Mark Local Parts for Ownership Transfer ; POM_imc 12345
4 Item
1673 cover_bolt c A 16F3nov_valve_cover_bolt_c A
-OoILE Yarve, couer BotL.c Check/Uncheck the checkbox to mark/unmark .
1663 cover bolt c A 16F3n0v_valve_cover_bolt ¢ A “ hl TtemID 16F3nov_valve_partial _assemt
1682 shaft_bolt c A 16F3nov_valve.shaft_bolt.c A Object Description:  16F3nov_valve_partial_assemt
163 bolt c A 16F3n ‘ Transfer [ Part Number Name m Object Name 16F3nov_valve_partial_assemt,
16F3n0v._v: 16F3n0v_valve_c 7|
4 16F3nov_valve_vendor_subassembly_c 16F3nov_valve_vendor subasses 1 O 1673 16F3nov._valve_partial_assembly_c A
% 16F3n0v_valve_shaft c A 16F3n0v_valve shaft c A 5 e [ p——
© 16F3nov_valve_arm_c A 16F3n0v_valve_arm_c A E
 16F3nov_valve cover ¢ A 16F3nov_valve.cover.c A 3 16F3nov_valve._shaft_bolt ¢ A 16F3nov_valve_shaft_bolt_c A
% 16F3nov_valve_key_c A 16F3n0v_valve key_c A 4 16F3nov_valve_c A 16F3nov_valve_c A
&L alve shaft_nut c A s 16F3nov_valve_vendor_subassembly_c A 16F3nov_valve_vendor_subassembly_c_A « il »
odunit_subassembl
6 16F3n0v_valve_shaft c A 16F3nov_valve shaft c A ) Datasets 2 % -0
7 ¥ 16F3nov.valve arm c A 16F3nov_valve_arm_c A Name Description  Type
8 16F3nov._valve_cover_c A 16F3nov_valve_cover c A 5 16F3nov_valve partial_z 16F3nov_val.. UGMASTER ¢

»
=5 Progress| i) Ownership Transfer 2 %~ 0

type filter text

©) oK Part Number Name.

16F3nov_valve_arm_c A 16F3nov_valve_arm_c A

Existing Structure  Properties

9JError Log ), ~ | B %~ =0
Workspace Log
type filter text

Message Plug-in Date

The parts marked for ownership will have the check box selected.
Select parts that you want to additionally mark for ownership transfer and click OK.

To unmark a part marked for ownership transfer, from the Existing Structure view, select that part
and right click to open a context menu Unmark Ownership Transfer.

Alternatively you can also unmark the parts from the Ownership Transfer dialog box. Clear the
check box against the part that is already selected for ownership transfer.

To transfer the ownership of the selected local parts, Click the save Briefcase button L.
Alternatively, you can choose File-»Save Briefcase.

The local parts whose ownership is now transferred are now read-only as they are now owned by
target site. These parts are indicated by the remote item symbol .




i Briefcase Browser

4. Using Briefcase Browser

File Tools Window Help
PR ale YIS 8lb

@D ibb_new\ ions\OTTest\data\16F3nov_valve_partial_assembly_c_A_A.prt &

Part Number [ Displays a briefcase or a briefcase comparison, J Description Revision CAD Attached JT Attached

4 16F3nov_valve_partial_assembly_c A 16F3nov_valve_partial_assembly ¢ A 16F3nov_valve_partial_asse.. A ¥

% 16F3nov_valve_cover_bolt_c_A 16F3nov_valve_cover_bolt_c_A 16F3nov_valve_cover_bolt_c.. A v

 16F3nov_valve_cover_bolt_c A 16F3nov_valve_cover_balt_c A 16F3nov_valve_cover_bolt c.. A v

“ 16F3nov_valve_cover_bolt c A 16F3nov_valve_cover_bolt c A 16F3nov_valve_cover_bolt c.. A L4

% 16F3nov_valve_shaft_bolt_c_A 16F3nov_valve_shaft_bolt_ ¢ A 16F3nov_valve shaft_bolt c.. A ¥

% 16F3nov_valve_shaft_bolt_c_A 16F3nov_valve_shaft_bolt_c_A 16F3nov_valve_shaft_bolt_c.. A v

\ 2 16F3nov_valve_c A 16F3nov_valve c A 16F3nov_valve c A A v

% 16F3nov_valve_vendor_subassembly_c A 16F3nov_valve_vendor subassembly_c.. 16F3nov_valve_vendor sub.. A v

% 16F3nov_valve_shaft_c_A 16F3nov_valve shaft_c A 16F3nov_valve_shaft c A A v

2 16F3nov_valve_arm_c_A 16F3nov_valve_arm_c_A 16F3nov_valve_arm_c_A A v

“ 16F3nov_valve_cover_c A 16F3nov_valve_cover_c A 16F3nov_valve_cover_c A A v

% 16F3nov_valve_key_c A 16F3nov_valve_key c A 16F3nov_valve_key c A A v

% 16F3nov_valve_shaft_nut_c_A 16F3nov_valve_shaft_nut_c A 16F3nov_valve shaft_ nut c A A ¥

4 % 16F3nov_valve_rodunit_subassembly_c_A 16F3nov_valve_rodunit_subassembly_c.. 16F3nov_valve_rodunit_sub.. A v

* 16F3nov_valve_rodend_c_A 16F3nov_valve_rodend_c A 16F3nov_valve rodend c A A v

1+ 2 16F3nov_valve_trod_nutbolt_subassen 16F3nov_valve_trod_nutbolt_subassem.. 16F3nov_valve_trod_nutbolt.. A L4

% 16F3nov_valve_housing_c A 16F3nov_valve_housing_c A 16F3nov_valve_housing c A A v
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5. Customizing Briefcase Browser

What you need to know and what you can customize

You must have an understanding of how to create an Eclipse plug-in to customize Briefcase Browser.
After you create an Eclipse plug-in project for your customization, you can create extensions for any
Briefcase Browser classes, the file launcher, and the synchronizer. You must set up an Eclipse project
for your customizations; the process is slightly different for each type of customization (file launcher,
synchronizer, preopen, postopen, presave, postsave, addDataset, and deleteDataset).

Create a plug-in project
1. Ensure that you have the correct Eclipse IDE version:
a. Start Briefcase Browser and choose Help—->About.
b.  Click Installation Details at the bottom of the About Briefcase Browser dialog box.

c. Inthe Briefcase Browser Installation Details dialog box, locate the version for the Eclipse
RCP feature. This is the version required to customize your version of Briefcase Browser. For
example:

__| Briefcase Browser Installation Details

Features Plug—ins| Configuration

Provider Feature Mame Version Feature Id

Eclipse.org Eclipse RCP 4.25.0v2022083... org.eclipse.rcp

Eclipse Modeling Project EMF Commaon 2.27.0,:2022081...  org.eclipse.emf.common
Eclipse Modeling Project EMF Ecare 2.29.0.v2022081... org.eclipse.emf.ecore

% Eclipse RCP
Version: 4.25.0420220831-1800 ="

Build id: 120220831-1300

(c) Copyright Eclipse contributors and others 2000, 2021, All rights reserved.
Visit http:/fwww.eclipse.org/eclipse

License Plug-in Details Celumns...

2.  Create your plug-in project:
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_ 5. Customizing Briefcase Browser

a. Startyour Eclipse IDE and choose New—>Project.
b. Inthe New Project dialog box double-click the Plug-in Project wizard.

c. Inthe Plug-In Project pane, type a name for your project in the Project name box. Modify
any other desired settings and click Next.

d. Modify any desired settings in the Content pane and click Finish.
Add a Briefcase Browser plug-in reference:
a. Right-click in the Package Explorer pane and choose Import.

b. Inthe Import dialog box, expand Plug-in Development and double-click Plug-ins and
Fragments.

Eclipse starts the Import Plug-ins and Fragments wizard.

c. Inthe Import Plug-ins and Fragments pane, select the Directory option, browse to the
plugins directory of your Briefcase Browser installation, and click Next.

d. Inthe Selection pane, type com.teamcenter.bce in the Filter Available Plug-ins and
Fragments box, select the following plug-ins, click Add—>, and click Finish.

* com.teamcenter.bce.core
* com.teamcenter.bce.editor
* com.teamcenter.bce.model
Add Briefcase Browser plug-in dependencies:
a. Inthe Package Explorer tab, expand META-INF and double-click MANIFEST.MF.
Eclipse displays the extension project Overview tab.

b. Click the Dependencies tab at the bottom of the center pane and click the Add button for the
Required Plug-ins list.

c. Inthe Plug-in Selection dialog box, type com.teamcenter.bce in the Select a Plug-in box to
filter on the Briefcase Browser plug-ins, select the matching items, and click OK.

d. Choose File—>Save to save the changes to the project META-INF/MANIFEST.MF file.
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Create a class extension _

Create a class extension

The class extension provides the class to call to access your other customizations.

1. Expand the project to the META-INF folder in the Package Explorer tab, and double-click
MANIFEST.MF.

2. Click the Extensions tab at the bottom of the center pane, and click Add in the Extensions pane.

3. Inthe Extension Point Selection dialog box, type com.teamcenter.bce in the Extension Point
filter box to filter on the Briefcase Browser extensions.

4. In the Extension Points list, select the extension point for the class you want to extend and click
Finish.

5. Inthe All Extensions pane, select the extension point child node (the extension point selected in
the previous step, see the following figure) and click class in the Extension Element Details pane.

4 o= com.teamcenter.bce.extension.PostBriefca:
[¥] tcbb.PostBriefcaseSavel (post-bec-save)

Eclipse displays the New Java Class dialog box.
6. Set the desired values and options for the new Java class and click Finish.

Caution:

You can modify the Interfaces box contents; however it must contain the reference to the
selected extension point that Eclipse adds by default. Do not remove this reference.

Create a file launcher extension

Create a file launcher if you want to launch an application to view or process a particular file type when
the user clicks it.

1. Create an icons folder in your Eclipse plug-ins project (choose New—>Folder). This creates a
directory in your customization project structure in the file system. Add the icon you want to use in
the toolbar for your file launcher to this directory.

Caution:

Ensure you include the icons directory in the binary build.

2. Expand the project to the META-INF folder in the Package Explorer tab, and double-click
MANIFEST.MF.
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_ 5. Customizing Briefcase Browser

Click the Extensions tab at the bottom of the center pane, and click Add in the Extensions pane.

In the Extension Point Selection dialog box, type com.teamcenter.bce in the Extension Point
filter box to filter on the Briefcase Browser extensions.

In the Extension Points list, select com.teamcenter.bce.extension.FileLauncher and click Finish.

In the All Extensions pane, select the launcher child node of the
com.teamcenter.bce.extension.FileLauncher extension (see the following figure) and click
Browse in the Extension Element Details pane.

Browse to the location of an icon file that you want to use as the toolbar icon for the launcher.

4 o= com.teamcenter.bce.extension.FileLaunche
4 |X| tcbb.FileLauncherl (launcher)
|X] TCBB file-typel (file-type)

In the All Extensions pane, select the file-type child node of the
com.teamcenter.bce.extension.FileLauncher extension and type the file extension in the
extension box in the Extension Element Details pane.

If you want to add more than one file launcher, enter a priority integer in the priority box.
The extension indicates the type of file this launcher opens.

A priority value of 1 is the highest priority. The priority value is used to determine which launcher
to use by default when the file type is included in more than one launcher.

To add additional file types to a launcher, right-click the launcher child node in the All Extensions
pane and choose New —file-type.

Eclipse adds a new file-type child node to the file launcher. Repeat the previous step for the new
file-type child node.

Create a synchronizer extension

Create a synchronizer extension if you want Briefcase Browser to be able to open a particular file type
and create a Briefcase file from it.

1.

Create an icons folder in your Eclipse plug-ins project (choose New—Folder). This creates a
directory in your customization project structure in the file system. Add the icon you want to use as
the toolbar and menu command icon for the synchronizer to this directory.
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Create a synchronizer extension _

Caution:

Ensure you include the icons directory in the binary build.

Expand the project to the META-INF folder in the Package Explorer tab and double-click
MANIFEST.MF.

Click the Extensions tab at the bottom of the center pane and click Add in the Extensions pane.

In the Extension Point Selection dialog box, type com.teamcenter.bce in the Extension Point
filter box to filter the Briefcase Browser extensions.

In the Extension Points list, select com.teamcenter.bce.extension.Synchronizer and click Finish.

In the All Extensions pane, select the synchronizer child node of the
com.teamcenter.bce.extension.Synchronizer extension (see the following figure) and in the
Extension Element Details pane:

* Type the extension for the type of file in a dataset that can be opened from the Briefcase Browser
Open dialog box or can be synchronized using the Briefcase Browser Refresh button.

* Browse to the location of an icon file that you want to use as the toolbar and menu command
icon for the synchronizer.

4 = com.teamcenter.bce.extension.Synchronize
[¥] (synchronizer)

5-5



_ 5. Customizing Briefcase Browser

5-6 Briefcase Browser, Teamcenter 2412
© 2025 Siemens



A. Troubleshooting

Determining what is wrong

If your site:

* Has sent data to a Teamcenter (managed) site prior to using Briefcase Browser

* Is defined at the Teamcenter as an offline (managed) site

You must perform an unmanaged site migration for the previously sent data to avoid errors and

unexpected results.

If you encounter...

A failure while saving the Briefcase in Briefcase
Browser

A failure while synchronizing or saving the
Briefcase in Briefcase Browser

An unhandled exception in Briefcase Browser

A failure when opening a CAD assembly from
Briefcase Browser on a 64-bit operating system

A failure when using a menu option or a button
in Briefcase Browser

A failure when opening or saving a CAD
assembly in Briefcase Browser when another
CAD product is installed on the same host as
NX

An error message when saving a Briefcase file
that contains new parts

An error message when opening or
synchronizing a Briefcase file on a non-English
operating system

NX does not launch when you double-click a
part file in Briefcase Browser

Then...

See SQL exceptions.

Ensure non-CAD attachments added to a part (either
automatically following the naming convention, or by
using the Add Dataset dialog box) are deleted from
the local instance. If an attachment is deleted from
the local instance, synchronize and save will fail for
the part.

See Fixing an unhandled exception error.

Ensure you are running a 64-bit Briefcase Browser
and NX applications on a 64-bit operating system.

See Null pointer exceptions.

See Causes of unexplained errors.

See NX part requirements.

Ensure the Format box in the Windows Region and
Language dialog box is set to the local language of

your Briefcase Browser application or to US English.

Otherwise, the date formats used do not match and
can cause this error.

See NX does not display a part when it is opened
from Briefcase Browser.
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_ A. Troubleshooting

SQL exceptions

If you open and modify parts that were created or used in an earlier version of Briefcase Browser (10.1
or earlier), from an existing working directory, an SQL exception may occur during the save action. This
happens when an update to the Briefcase database contains new or modify attributes or elements.

To avoid this, delete any existing folders with old database files (attributes.db and elements.db) before
opening the parts in a newer Briefcase Browser version.

Importing a Briefcase file in Teamcenter fails after migration

After migrating Briefcase Browser to Teamcenter, while trying to export data from the migrated
Teamcenter to other site an error occurs.

To avoid this, you should set the opt_all_ds_vers option set value to true.

Fixing an unhandled exception error

If the Briefcase Browser error log contains an error message similar to the following:
Unhandled event loop exception

A third-party tool may be hijacking the Java process environment.

To resolve this issue, remove the third-party tool or change the JAVA_ARGS or JAVA_OPTS environment
variable values to the Briefcase Browser required settings.

Null pointer exceptions

Briefcase Browser is an Eclipse-based Java application. See Requirements for using Briefcase Browser
for Java Runtime Environment (JRE) requirements

If you encounter errors in Briefcase Browser, such as a null pointer exceptions, you may be running an
incompatible JRE version. Ensure that your JRE meets the stated requirements and its location is in your
PATH environment variable.

If the JRE version and PATH variable are correct ensure that you copied or extracted the JRE contents
into the directory that contains your Briefcase Browser application (BriefcaseBrowser.exe) during the
installation procedure.
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Causes of unexplained errors _

Causes of unexplained errors

Unexplained errors are normally a configuration issue. Ensure that you have the UGII_ROOT_DIR,
UGII_BASE_DIR, and PATH environment variables set properly as described in the installation
instructions and that you have the JRE installed and configured.

If you have another CAD product, such as Pro/ENGINEER, installed on the same host as your NX
application, add the UGII_ROOT_DIR environment variable to the front of the PATH environment
variable.

NX does not display a part when it is opened from Briefcase
Browser

On systems where Teamcenter Integration for NX is installed, the .prt extension is associated with
Teamcenter Integration for NX. When you double-click a .prt file the operating system tries to open it in
Teamcenter Integration for NX. Because Teamcenter Integration for NX does not support opening local
files, it does not display the part. This behavior is retained even if have the NX application installed. If
you double-click a .prt file it launches NX but does not open the part file. Therefore, if you select an NX
part file in Briefcase Browser and click Launch NX, NX opens but does not display the part.

This is due to the Windows file associated for the .prt extension being set to the wrong program. You
must change the file association to open the file with NX.

Change the file association to use the following command to open part files in NX:
NX-installation-directory\UGI I\ugs_router.exe'" -ug -use_Ffile_dir "%l

The instructions for changing the Windows default program used to open a file type are provided for
your operating system at:

http://lwindows.microsoft.com
To change this association in the Windows registry:
1.  Start the registry editor by typing regedit in the start menu search box.

2. Choose Edit—>Find, type ugs_router.exe in the Registry Editor Find dialog box, and select the Key
option.

3. Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Classes\UGpartfile\shell\open\command.
4.  For NX 11 or later, type NX-install-directory)\UGII\ugs_router.exe" -ug -use_file_dir "%1".

5.  For versions prior to NX 11, type NX-install-directory\nxbin\ugs_router.exe" -ug -use_file_dir "%1".
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B. Migrate a managed supplier site to an
unmanaged site

You can change a supplier site that has previously been defined as a managed site in Teamcenter to

an unmanaged site without causing any data errors for previously transferred data. This procedure
designates the site migrating to an unmanaged site as the supplier site and the OEM site as a managed
site.

1. At the supplier site, identify all assemblies that were sent to the OEM site.
2. Ensure that any shared data is not checked out to a remote site.
3. Create new revisions for all shared items:

a. Turn off the smart baseline feature by changing the value of the ITEM_smart_baseline
preference to 0.

b. Atthe supplier site, create a baseline of the supplier data that has been sent to the OEM site.

All new revisions occur in the migrated unmanaged site. Shared objects have multiple
revisions, and OEM replica parts are not baselined.

4. If the supplier site is a hub site, in the Organization application, clear the Is a Hub check box for the
supplier site.

5. At the supplier site, export all supplier-owned objects to a Briefcase file.
a. Choose Tools—>Export—>To Briefcase.
b.  Select the unmanaged site and click the Display/Set remote export options button &.

c. Inthe TIEConfiguredExportDefault dialog box, select the Replica Bypass check box.
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_ B. Migrate a managed supplier site to an unmanaged site

10.

' TIEConfiguredExportDefault .

Relations ~

Include JT Datasets
Include MNX Datasets

Include IMAMN_based_on

[] Include NX drawings

[ Include NX{UGPART) manifestation

[ Include JT if NX not found
Include MX scenario

[ Include NX simulation dataset
Include MX part family templates

Include Altrep (MX Alternate represent

[ Include NX Motion dataset

[] Include JT as dependent object

Dataset Options
Include All Files

Include All Versions

Dataset version 0 only

< m >

| 0K || Cancel |

Export all baseline assemblies for migration. This includes:
* New baseline assemblies that were previously sent.

* Supplier-owned data.

* OEM replica data that must be preserved.

Install Briefcase Browser at the supplier site being migrated using the same site ID as the managed
site for the unmanaged site.

In Briefcase Browser, extract all Briefcase files in the migration working directory.
Confirm that the Briefcase files extracted meet the OEM requirements.
Notify the Teamcenter administrator at the OEM site that the Briefcase file output is as expected.

In the Organization application at the OEM site, modify the previously managed supplier site by
selecting the Unmanaged option for the site.
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11.

12.

At the unmanaged supplier site, use Briefcase Browser to add parts to new assemblies. You can
copy the required .prt files to a new working directory and create Briefcase files based on them.

Transfer the Briefcase files to the OEM and import them into Teamcenter using
Tools—>Import->From Briefcase.
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